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Chapter

1
Introduction

Topics:

• Kubla Software
• Kubla Cubed

Welcome to the Kubla Cubed user guide. Kubla Cubed is a general-purpose
volumetric calculation tool. It employs a cutting-edge TIN-based volumetric
calculation engine to estimate cut and fill in a diverse range of scenarios.
Innovative and powerful design tools are available to complete volume
estimates for various scenarios, including site stripping, bulk earthworks,
building pads, ponds, roads, retaining walls, stockpiles, marine dredging, and
many others. Whether you are performing a complicated take-off from PDF
drawings or comparing two surveys, Kubla Cubed has all the tools you need
to get the job done.



Kubla Software

Kubla Ltd is an engineering software company formed in 2013, with headquarters in Bristol, UK, known for being the
home of Britain’s most famous engineering accomplishments, including the Clifton Suspension Bridge and the iron-
hulled vessel SS Great Britain—both engineered by the celebrated engineer, Isambard Kingdom Brunel.

As an innovative software company, we focus on creating applications for engineering, surveying and construction
professionals. Our solutions are utilised globally, on projects that span from the design of dredging works to the
everyday production of accurate earthworks bids.

Our software products are developed in-house, by specialists in engineering, surveying and graphical visualisation.
We pride ourselves on developing bespoke and off-the-shelf solutions which are both cutting-edge and exceptionally
user friendly. By concentrating on software design and support we help our users to focus on engineering problems
through effectivesoftware solutions.

Kubla Cubed
Kubla Cubed provides a range of tools for recording earthwork data and measuring the results. Data can be input
manually, extracted from Vector data in PDFs and imported from CAD files. Additionally, there are a variety
of export options available to export designs into a CAD or LandXML files or generate images, reports, and
spreadsheets for project documentation.



Chapter

2
Getting Started

Topics:

• User Interface
• Setting the Correct Units
• Changing Background Colour
• Cursor Label
• Navigation
• Undoing and Redoing Changes
• Selecting Elements
• Loading and Saving Files
• Keyboard Shortcuts / Hotkeys

Within this section, you will discover the various components of the
application and gain insights into how to interact with them.
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User Interface
The quickest way to get started with Kubla Cubed is to open an example file. When you click on File and then Open
you will see a list of example files which you can start with. Once you have opened a file, the window will appear as
shown below:

This image shows the Elevation Elements menu open. Double click on "Measurements" to open the measurements menu.

The different elements of this user interface are briefly described below:

• ① Design Area  - This is the main display where the existing ground and the proposed earthworks will be
displayed.

• ② Elevations Panel - This panel is used for adding, removing and editing the earthworks elements, which are
combined together to create a proposed surface.

• ③ Measurements Panel - This panel is used for adding, removing, and editing the measurement elements (e.g.,
Lengths, Areas, Counts). You can open this panel by double clicking on the header "Measurements"

• ④ Display Panel - This panel is used for changing various display options (e.g., camera controls, lighting and grid
lines, site plans).

• ⑤ Navigation Panel - The controls in this panel can be used for zooming, panning, and rotating (in 3D) the views.
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• ⑥ The Results Panel - The results panel shows an overview of the earthworks estimation for the current phase. A
more detailed analysis can be produced in a report or spreadsheet.

• ⑦ The Colour Keys - These colour keys show the shading used to display the existing and proposed topography.
• ⑧ Construction Phases - The bottom of the first tab shows the existing ground; subsequent tabs show phases of

proposed earthworks.

Start your own project

When you are ready to start your own project, the first step is to add your site plans, do this by selecting 'Add PDF/
CAD/Image File' from the Plans menu (you can skip this step if working exclusively with CAD or XYZ point files).

To start defining existing elevations, make sure the Existing tab is selected and then in the Elevations panel on the
right-hand side click on the + symbol and add a Feature Surface or a Triangle Surface.

This will open a window that allows you to define existing ground elevations or import a triangulated mesh from
a file. Once you have done this, you can create and edit proposed earthworks by selecting the Proposed 1 tab and
adding earthworks elements such as Platforms, Slopes, Reduce elements or another Feature Surface.

Learn about Kubla Cubed site plans in our video Site Plans - Overview.
Become familiar with earthwork estimations tools in Proposed Levels -
Overview. Dive into an example project with our walk-through videos.
and find stand-alone video tutorials on our website.

Setting the Correct Units
Kubla Cubed can display either metric or imperial (English) units. These will initially be set to a default value
depending on the region settings of the computer. The initial settings can easily be changed by clicking on Settings in
the menu bar and then Measurement Units.

① Units - For each measurement type (volumes, areas, positions and short lengths), you can select the desired unit of
measure. It is recommended that you do not mix imperial and metric units together. For instance, if areas and volumes
are set to yards, then positions should be set to feet.

https://youtu.be/G2V8QG05gs4
https://youtu.be/jwByj4SLG1U
https://youtu.be/jwByj4SLG1U
https://www.kublasoftware.com/videos/cubed-2024-videos/#walk-throughs
https://www.kublasoftware.com/videos/cubed-2024-videos/#getting-started


 | Getting Started | 12

② Precision - For each measurement type, you can also change the precision displayed in the program. It should be
noted that this has no effect on the calculation engine precision, only the display. The default is two decimal places,
which is sufficient for most earthworks projects.

Notes on Sharing Files : All Kubla files are saved with the same units internally. The display settings that can be
changed in Kubla Cubed only affect the way the units are displayed to the user. They do not change how the units
are saved internally. This means that if you share a file with another user, the file will display correctly in whatever
units they have selected as their preference. This can cause complications if a site plan is marked in different units
than what the user has selected; however, if this happens, it is simple to synchronise the display units to match those
marked on the site plan using the above options.

View application settings (not project settings) in our video Kubla Cubed
Quick Tip | Change Units of Measure.

Changing Background Colour
Options for changing the background colour can be accessed via the 'Colours' menu and then selecting 'Background'.
The colour can be modified by clicking on the square next to the word 'Colour'. There are a range of pre-defined
colours but custom colours can also be created.

Moving the horizontal slider within the 'Panel Transparency' section furthest to the right, will make the entire
interface completely opaque. Likewise, sliding fully left will render everything but text and essential interface
options, fully transparent.

See application settings in our quick tip video Kubla Cubed Quick Tip |
Changing Background Panel Colour .

https://youtu.be/ZUdjmwutu8A?si=N9C30w5e6Pe8aNuY
https://youtu.be/ZUdjmwutu8A?si=N9C30w5e6Pe8aNuY
https://youtu.be/S_Wloa1B__A?si=5MqrCjWBRNqnQ5t0
https://youtu.be/S_Wloa1B__A?si=5MqrCjWBRNqnQ5t0
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Cursor Label
As the mouse cursor is moved around your project, a label can be displayed in real-time, containing data about the
position underneath. The label can include the element name, X and Y co-ordinates, existing/proposed elevations, and
cut/fill values. The label options can be customised to show only the information you require.

In the project's design area, the label reveals information about the point on the surface underneath the cursor. Using
the settings menu, you can customise the displayed information, including the X,Y co-ordinates, existing/ground level
(Z: (Ground)), proposed level (Z: (Proposed)) and the Cut and Fill. For example, the image below displays: Element
Name, X:324,105.64ftE, Y:680,435,30ftN, Z: 5046.90ft (Ground), Z: 5050ft (Proposed), Fill: 3.10ft.

To access the cursor options, click on the 'Settings' menu bar and then select 'Cursor'. Here, the available items that
can be displayed in the cursor label can be turned on/off (shown in the image above).

Notes on Copying the Label Contents : Sometimes, there is a requirement to copy the contents of the cursor label.
While you can manually copy it down, this can be time-consuming and lead to mistakes. To copy the contents of
the cursor label to the clipboard, ensure that the 'Measure Tool Copy' is ticked in the cursor menu. Then, simply tap
the 'M' key. This will activate the quick measure tool and copy the contents to the clipboard. After copying, go to
a document/spreadsheet and paste using either the 'Edit' menu of the program or the universal 'Ctrl+V' shortcut for
pasting. For more information see Quick Measure Tool .

See application settings in our quick tip video Kubla Cubed Quick Tip |
Change the Cursor Label .

Navigation
Navigation is done either using the mouse, the keyboard, or the buttons on the navigation panel. The way the
navigation works depends upon the camera you have selected for display.

You can choose whether you want to navigate through each phase independently or sync navigation between phases.
The best option can depend on the situation. If each phase is focused on different parts of the site, it may be easier
to navigate independently. Conversely, if each phase is building up parts of the same area it can be easier to sync the
navigation. To toggle this setting, you can click on View and then Single Camera Mode.

There are three different cameras that you can use to display and navigate in Kubla Cubed, as described below.

https://youtu.be/1NqvwuX5pL0?si=nw2ta5UYLStRgl14
https://youtu.be/1NqvwuX5pL0?si=nw2ta5UYLStRgl14
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When you change the cameras, the controls for navigation will also change.

Design View

This option displays the project in plan view (2D) from above. You must be in this view to draw
lines to create all design elements except for the surface.

3d Orbit View

This 3d view is used to orbit around the centre of the terrain, as well as to tilt the view up and
down.

3d Flyover View

This 3d view is used to fly over the existing terrain and allows the user to move forward and
backward and rotate the view in all directions.

The following controls are the same regardless of the camera you have selected.

Zoom In

Keyboard: '+' key

Mouse:  Scroll Wheel Forwards

Zoom Out

Keyboard: '-' key

Mouse:  Scroll Wheel Backwards

Zoom to Extents

This button zooms to frame all visible items.

Zoom to Selection

This button zooms to frame the selected element.

The rest of navigation controls depend upon the camera you have selected.

Navigation in 2D Design View

The following controls are available to navigate in design view, in addition to the general navigation controls
described above.

Pan Right

Keyboard: 'right arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Right

Pan Left

Keyboard: 'left arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Left
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Pan Up

Keyboard: 'up arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Up

Pan Down

Keyboard: 'down arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Down

Navigation in 3D Orbit View

The following controls are available to navigate in orbit view, in addition to the general navigation controls described
above.

Orbit Right

Keyboard: 'right arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Right

Orbit Left

Keyboard: 'left arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Left

Orbit Up

Keyboard: 'up arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Up

Orbit Down

Keyboard: 'down arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Down

Navigation in 3D Flyover View

The following controls are available to navigate in flyover view, in addition to the general navigation controls
described above.

Move Right

Keyboard: 'right arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Right

Move Left

Keyboard: 'left arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Left

Move Forward

Keyboard: 'up arrow' key
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Mouse:  Press Scroll Wheel and Move Mouse Up

Move Back

Keyboard: 'down arrow' key

Mouse:  Press Scroll Wheel and Move Mouse Down

Look Right

Mouse:  Press Left and Right Buttons and Move Mouse Right

Look Left

Mouse:  Press Left and Right Buttons and Move Mouse Left

Look Up

Mouse:  Press Left and Right Buttons and Move Mouse Up

Look Down

Mouse:  Press Left and Right Buttons and Move Mouse Down

All cameras are described in Getting Started - Navigation. Use the
following links to access the camera of interest.

• Design View Camera
• 3D View Camera
• 3D Flyover Camera

Undoing and Redoing Changes
Each successive change to a project may be undone or redone by selecting the Undo and Redo options in the Edit
menu.

Alternatively, undo and redo via the shortcut keystrokes: Ctrl+Z for undo and Ctrl+Y for redo. The resulting changes
will display in the 2D and 3D views.

Selecting Elements

Select Disturbance Areas

https://youtu.be/BPZPtS4kRWg
https://youtu.be/BPZPtS4kRWg?t=70
https://youtu.be/BPZPtS4kRWg?t=137
https://youtu.be/BPZPtS4kRWg?t=174
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The selection highlights in 2D or 3D to identify the elements within a selection. It draws attention to the element's
location on both the panel and the model, which is not always clear in larger projects.

• Left-click to select an element and turn flashing on.

• Select by clicking on the listed element in the elevations panel.
• Select by clicking on the 2D or 3D surface.
• Hold down Ctrl and left-click to select multiple elements.
• Group select by holding down the shift key whilst clicking on the first then last item.

• Right click to turn flashing off.

Loading and Saving Files
Loading and saving strategies are essential as a project develops to recover from mistakes and application crashes.
These include manual saving, loading, and auto-recovery.

Loading Projects

New Project

Create a new project either by opening Kubla Cubed, or if the software is open, go to the menu option

File → New Project.

Open Existing Project

Projects can be loaded through the menu option: File → Open Project, which initiates a file selection window.
Alternatively, for a swifter approach, you can select a project from the list of recently loaded projects via the menu
option File → Recent Projects.

Saving Projects

Once a project has been created or amended, it needs to be saved. It is recommended to save multiple versions of
projects frequently so that previous versions can be restored if mistakes are made. Projects can be saved manually via
the menu options File→Save Project, which will overwrite the original project, or with a different project name via
the menu option File→Save Project As

Additionally, an auto-recoverable backup copy of manually saved projects will be automatically created and kept until
older files are deleted (see auto-recovery sweeps). These auto-recovery backups can then be restored later.

The image displays file dropdown options, including "Open Project," "Recent Projects," "Save Project/As," and "Auto-Recovery".
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Auto-Recovery

Auto-Recovery

Your manual save location, stores the most recent version of your project. However, auto-recovery preserves previous
versions (older manual saves) in addition to auto-saves.

Auto-Recovery Settings

This feature can be switched on via the menu option:

File→ Auto-Recovery→ Options

where a list of backup intervals is available, ranging from one to 30 minutes.

Note:  The automatic backup interval is timed from the last project amendment to prevent excessive saving when no
changes have been made.

Auto-Recovery can be switched off using the menu option File→ Auto-Recovery→ Options→ Off. This option is not
recommended, unless disk space is limited.

The ‘Off’ option will not create auto-recovery backup versions, so only manually saved projects will be available for
loading via the File menu options Open Project or Recent Projects. To save different versions with auto-save set to
off, the project name will have to be changed manually on every save.

If the backup becomes obtrusive, the recommended alternative method for turning off auto-save is to use the menu
option File→ Auto-Recovery→ Options→ Only On Manual Save.

This will save an auto-recovery version in addition to projects saved manually (via the menu options

File→ Save Project or ‘Save Project As’) and can then be later restored via auto-recovery loading.

Recovering Projects

There are two methods for recovering previous versions of files saved manually or via auto-save:

1. via the Auto-Recovery Restore Window, shown on opening Kubla Cubed.
2. via the menu option File → Auto-Recovery → Recover.

Restoring Projects After Application Crash

In the event of an application crash and the project was saved beforehand, the Auto-Recovery Restore window will
be automatically displayed when the application is restarted. This window lists all previously saved versions of the
last saved project that was being amended when the application crashed, along with options to restore one of them. To
restore the latest or an older project version, press the “Restore” button alongside the corresponding project name and
the time it was last saved.
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The 'Restore from Auto Recovery' window displays after restarting the application following a crash. It shows the latest and previous versions of projects that

can be restored.

Restoring Previous Project Versions

Previously saved versions of a project may be restored manually by choosing the project via the menu option File →
Auto-Recovery → Recover, which lists all recently saved project versions along with their saved times.

Auto-Recovery menu, displaying available auto-saved version history options for project recovery.

Deleting Auto-Recovery Versions

Deleting an auto-recovery version will prevent that version from being restored and is not recommended unless disk
space limited, a project is no longer needed, or needs removing for confidientiality reasons. The preferred method is
to allow the auto-recovery sweep to automatically delete older project versions as newer versions are saved.

Auto-recovery versions of a project may be deleted manually by choosing the project via the menu option

File → Auto-Recovery → Delete, which lists all recently saved project versions along with their saved times and
appears similar to the Auto-Recovery → Recover option.



Auto-Recovery Sweeps

To free up disk space, an auto-recovery sweep will automatically be performed to delete older project versions as
newer versions are saved.

All auto-recovery saves for each project within the hour are kept, along with hourly projects within the day, daily
within the week, weekly within the month, monthly within 6 months and quarterly within the year. Any auto-recovery
saves older than a year are deleted.

Although you will have your auto-recovery files, we still recommend you save your own versions of your project to
avoid any loss of work.

Keyboard Shortcuts / Hotkeys
Shortcuts enhance the users experience of Kubla Cubed, increasing efficiency by minimising the time it takes to
perform tasks, while providing flexibility when working on projects.

Function Shortcut Keys

Undo Ctrl + Z

Redo Ctrl + Y

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Presentation Mode Ctrl + F

Measure a length. M (hold and move cursor along length)

Add a point to a section of a drawn line. Z (select line section and tap)

While drawing a line, remove the previous point. Backspace ←

Escape from an operation or Exit Presentation Mode. Esc

Zoom to extents. Home



Chapter

3
Display

Topics:

• Display Panel
• Element Shading
• On-Screen Statistics
• Single Camera Mode
• Presentation Mode
• Colour Keys
• Vertical Exaggeration

You have the flexibility to customise the display of your project in
several ways, such as choosing the camera type, selecting surface shading
preferences, and toggling the display of incline lines for side batter slopes.
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Display Panel
You can customise the display of your project in a number of ways, such as selecting the camera type, defining the
surface shading, and deciding whether to display incline lines for the batter slopes.

Within the Display panel, you will find the controls which are used to adjust the display for the current phase.

It is important to note that lines are not currently displayed in either of the 3D views. Consequently, all controls
related to the display of lines will be disabled when either of the 3D cameras are selected.

Camera Selector

This dropdown allows you to choose the camera used to display the project. It is used to determine
whether you are displaying in 2D or 3D modes. For more information, see Cameras.

Lighting Mode

This dropdown allows you to choose the lighting used to display the project. Options include Hard
Lighting, Soft Lighting, and No Lighting. Lighting on page 22

Earthworks Shading Mode (Not in Existing Tab) Element Shading on page 24

This dropdown allows you to choose the method used to shade the proposed earthworks. Options
include Earthworks Cut & Fill, Earthworks Levels, Match Ground, and Element Colours.

Line Visability  (Not in Existing Tab)

This dropdown allows you to choose the lines displayed for the proposed earthworks. Options
include Incline Lines, Outlines Only, and No Lines. Line Work on page 23

Site Plan Visibility

This button allows you to display site plans in different views. Options include All Views, 2D
Views, 3D Views, and No Site Plans. Site Plan Visibility on page 23

Toggle Selection Lines (Not in Existing Tab)

This button allows you to choose the turn the selection lines for the earthworks elements on and
off.

Toggle Grid Lines

This button allows you to turn the grid lines on and off.

Lighting

There are three different lighting options that can be used to display the existing and proposed terrain, as described
below.

Hard Lighting

This option will light the terrain with hard edges. This lighting mode gives a clear representation of
variations in slopes throughout the terrain and is particularly useful for validating defined levels.

Soft Lighting

This option will light the terrain with smoothed edges. This can give a visually attractive
representation of the terrain. However, it can also smooth hard edges in the terrain which can
provide an unrealistic representation of the ground levels.



 | Display | 23

No Lighting

This option turns off all lighting. This option is useful for clear representations (particularly in 2D)
which show the difference in levels by colour and where the variation in slope does not need to be
visualised.

Line Work

There are three options for the display of earthworks lines as described below.

Incline Lines

This option will display the outlines of the earthworks, as well as lines indicating the direction of
the batter slope.

Outlines Only

This option will display only the outlines for the earthworks.

No Lines

This option will not display any lines for the earthworks.

Earthworks Shading

There are four modes than can be used to shade the earthworks.

Shade Earthworks Cut / Fill

This option will colour the earthworks by cut / fill depth. It is particularly useful for visualising
where the cut and fill will be highest in the project area.

Shade Earthworks Levels

This option will colour the earthworks by level with a totally independent colour scheme to that
used by the existing terrain. This is useful when you need to show the earthworks levels, but you
want to make a clear distinction from the existing ground.

Match Ground Shading

This option will colour the earthworks exactly the same as the existing ground so that it appears
as a single surface. This mode is useful for quickly visualising what the final terrain will look like
once the earthworks are completed.

Element Colours

This option will colour the earthworks to an automated colour selection (or a colour of your
choice), to show the extent of the reporting area for each element type (building pad, garage, soft
landscaping etc.) that is in a project. This is useful to quickly locate a particular group of elements
(e.g. all building pads).

Site Plan Visibility

There are four options for the display of site plans as described below.

Site Plans in All Views

This option will display site plans in all model views (2D and 3D).
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Site Plans in 2D Views

This option will display site plans in the 2D model view only.

Site Plans in 3D Views

This option will not display site plans in the 3D model view only.

No Site Plans

This option will not display any site plans.

The Site Plans - Layering in 2D and 3D video shows how to selectively
display site plans in 2D and 3D, via the layering and visibility options.

Element Shading
In a proposed phase, you can choose between four different ways to shade the surface. To change to different shading
modes, click the Shading dropdown in the Display Panel.

The four shading modes and their differing impacts on the way the surface is coloured are shown below:

Shade Earthworks Cut/Fill Shade Earthworks Levels

https://youtu.be/j5of3829kO4
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Match Ground Shading Element Colours

• Shade Earthworks Cut/Fill: This mode shades the proposed earthworks based on cut depths and fill heights. It is
the default shading mode, and unless you customise the colour key, it shades the proposed surface red in cut areas and
blue in fill areas. Deeper cut sections are coloured a darker red, and higher fill areas a deeper blue. You can customise
the ‘Proposed Cut & Fill’ colour key.

• Shade Earthworks Levels: This mode shades the proposed earthworks by elevation. It is a common shading
technique used in cartography and can help identify high and low points in your proposed design, providing a greater
understanding of elevation changes across your surface. Customise colours at different elevation bands by editing the
‘Proposed Levels’ colour key.

• Match Ground Shading: Selecting ‘Match Ground Shading’ matches the shading of the proposed surface to that
used by the ground surface. The ground surface is shaded by elevation in the same way as the ‘Shade Earthworks
Levels’ option, with the only difference being that the ground surface and proposed surface share the same colour key.
Customise colours at different elevations by editing the ‘Ground Levels’ colour key.

• Element Colours: In this mode, different elements are shaded in a variety of colours. This simple shading scheme
is useful for understanding element overriding. Elements that intersect can override each other. Absolute elements
always override higher elements, and relative elements override higher relative elements (with default settings).
Shading by element colours helps visualise which element is overriding others in these scenarios. The coloured area
of each element corresponds to the reporting areas used in the element breakdown in the estimation data spreadsheet/
report.

Elements are automatically assigned a colour on creation, but you can modify the colour of an element by double-
clicking on the colour swatch (the ‘Colour’ option only appears when in Element Colours mode).
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On-Screen Statistics
The Cut, Fill and Cut & Fill summaries for the selected phase are displayed in the top left corner. These are hidden
while editing elements. Options determining the level of detail are set within the Project Settings, which are found in
the top menu under Settings → Onscreen Results.

In the image below, all options have been ticked/enabled.

Single Camera Mode
Each phase can have a separate camera assigned, but these can be synchronised. The decision on whether to navigate
through each phase with its own camera or to sync navigation between phases depends on the situation. If each phase
is focused on different parts of the site, it may be easier to navigate independently. However, if each phase is building
up parts of the same area, synchronising the navigation can be more efficient.

When Single Camera Mode is set, all phases will begin using the same camera as used on the current phase. To toggle
this setting, in the menu, select View → Single Camera Mode.

Presentation Mode
Kubla Cubed features a presentation mode for showcasing the software in presentations. This mode removes all
the editing controls as well as the title bar, providing a full-screen view of the relevant project content. To enter
presentation mode, click on the View menu and then Presentation Mode. Alternatively, press Ctrl and F together
(CTRL+F). Press Escape (Esc) to exit.
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Colour Keys
The shading schemes used to display the terrain and earthworks are customisable by the user. Kubla Cubed comes
with a number of pre-set colour tables with options for user customisation, such as choosing between discrete and
beleded shading.

Additionally, users have the capability to generate their own colour tables for fully customised output.

The shading schemes used to display the terrain and earthworks can be fully customised. The 'Colours' menu provides
options for editing the shading schemes for 'Ground Levels', 'Proposed Levels', and 'Proposed Cut & Fill'. Each
earthworks display mode uses different shading schemes:

• Match Ground Shading  - Ground Levels.
• Shade Earthworks Levels  - Ground Levels and Earthworks Levels.
• Shade Earthworks Cut & Fill  - Ground Levels and Earthworks Cut & Fill.
• Colour Elements - Defines each element with its own colour to show overriding elements. Colours can be edited

in Elevations panel. See Element Shading.

A shading scheme consists of a table of colours with corresponding values ②. There is a library of these colour tables
to choose from, and a shading scheme's colour table can be changed by selecting a different one from a drop-down
box ①. You can manage the library of colour tables by deleting ④ those that are no longer needed, as well as creating
and amending existing ones with the Edit or Edit Copy buttons ③.

On the right-hand side of a shading scheme tab, there are options for controlling the way the colour table is applied
to a surface (i.e. the existing ground or earthworks). When you select different options, the diagram ⑧ updates to
display where on the surface the colours will be applied.

Apply Colours Using ⑤ - This is where the method for applying the colour table to the surface is chosen. The two
methods are:

• Relative: A shading scheme using the relative shading will scale the scheme to fully cover the surface being
shaded. For this reason, in relative mode, colour table values show as percentages. This method ensures that the
surface uses the full range of colours in the table, adapting as the design changes.

• Absolute: The absolute method applies colours using the exact values in the table, providing total control over
where the colours are applied on the surface. However, it does not adapt when new terrain is loaded or earthworks
changes, so it may need to be manually adjusted when there are significant alterations to a project.
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Shading ⑥ - There are two different shading options: Discrete and Blended. With Discrete shading, colours are not
blended, resulting in discrete blocks of the same colour. When Blended is selected, the surface is shaded by smoothly
interpolating between the colours in the colour table. See the image below for an illustration of the difference between
these two shading modes.

A consequence of using an absolute scheme with discrete shading is that the last colour in the table will not be used.
This is because the first two values are used for the range of the first colour, the second and third for the next, and so
on, resulting in the last colour being redundant. In relative mode, the values are adjusted to make use of all the colours
in the table.

Zero Lock ⑦ - When shading a surface, it's often necessary to lock a particular colour to zero. For example, when
shading terrain, you might want a colour locked at zero to indicate the difference between land and sea, or to show the
areas on a platform in different colours for cut and fill (in difference shading mode). With absolute shading schemes,
this is simply a matter of setting a colour value to zero. However, with relative shading, it is a little more complex, as
the 'zero' value moves as it scales to fit the surface being shaded.

To resolve this, there is a zero lock feature that locks any colour with a value of zero to zero on the surface. The two
different zero lock options are:

• Scale ± Independently: This scales both positive and negative values independently, ensuring the colour table
covers the entire surface. This is useful when aiming to display the full range of colours in the table for maximum
contrast.

• Scale ± Equally: This option scales values above and below zero equally. It is useful in various situations,
particularly for a cut and fill shading scheme, providing a sense of depths of cut compared to fill. However, with
this option, not all of the values in the table will be displayed.

Learn about the shading scheme options in our video  Adjusting Shading
of Surfaces, featuring a demonstration on creating custom schemes.

https://youtu.be/bn8z98mouUw
https://youtu.be/bn8z98mouUw
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Vertical Exaggeration
When the model is in 3D mode, a vertical slider will appear on the bottom left corner of the screen. The purpose is
to exaggerate the visualisation of elevation differences – it does not alter the values or calculations. This feature is
beneficial when checking that there are no erroneous extreme values, or to emphasise differences in the terrain when
working with a relatively flat model. See Visualisation on page 139.

Dragging the slider's handle upward will increase the exaggeration. Dragging the handle downward will reduce
exaggeration.

3D Orbit View camera in use; left without vertical exaggeration, right with maximum vertical exaggeration. Calculations remain unchanged as the
exaggeration applies to the visualisation only.
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Site Plans

Topics:

• Overview
• Quick Measure Tool
• Editing Modes
• Adding a Site Plan
• Setting the Position and

Cropping
• Stitching Site Plans
• Overlaying Site Plans
• Setting the Transparency
• Setting Visibility

Site plans can be loaded into Kubla Cubed and displayed on the screen.
This functionality allows the user to trace lines off the loaded plan and
maintain a general awareness of the location of objects in the real world.
Kubla Cubed supports the following file groups: PDF, CAD, and Image
(e.g., .png, .jpg .gif).
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Overview
Kubla Cubed allows you to load site plans into your project from a number of different file formats such
as .pdf, .jpg, .bmp, .tiff. You can also import a site plan from CAD (.dwg). You have the flexibility to import as many
site plans as needed, switching them on and off when you need to view them.

Displaying multiple site plans simplifies the process of completing a take-off, especially when your existing and
proposed elevation data are on two separate drawings. You can also use the crop, move, and align tools, allowing you
to to 'stitch' drawings together in situations where a single site plan is spread across separate pages of a document.

Site plans can be adjusted by clicking on the Plans menu item. The menu item will appear as shown below.

This is where your site plans are listed.

• ① Click here to add a new site plan. You can load site plans from CAD, PDFs or image file formats
(.bmp, .jpg, .tiff)

• ② This is where the list of your site plans are listed. See Setting Visibility for more information.
• ③ Use this menu to Edit, Delete, Hide or Move site plans. Moving plans up/down within the list restricts visibility

on proposed, ground and/or surround.

You can add as many site plans as needed, allowing you to show a site which is presented on multiple drawings, or to
show both the existing and proposed, even if they are in separate drawings.
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The Site Plans - Overview video quickly demonstrates options for
adding, modifying, and viewing site plans.

Quick Measure Tool
It is often necessary when creating a project to do a quick measurement of a length, especially after a site plan has
been scaled or CAD data imported. Checking a known length can ensure that no mistakes have been made when
scaling or selecting the units of CAD data. To activate the quick measure tool, hover the mouse over the point you
want to measure from and press the M key. While keeping the M key pressed, move the mouse to the next point, and a
yellow line between the two will be displayed with a cursor label showing the '2D Distance'. The measure tool can be
used in the 2D Design view where project data is displayed.

Measure Tool Copy

By default, the quick measure tool displays the 2D Distance measured in a label next to the cursor. However, you can
copy details of each measurement to the clipboard if required. To do this, you need to make sure that Measure Tool
Copy is ticked in the cursor menu. After completing a measurement with the M key, the details of the quick measure
operation will be copied to the clipboard. After copying, go to a document or spreadsheet and paste either using the
Edit menu of the program or using the universal Ctrl+V shortcut for pasting.

Editing Modes
There are two modes of editing available in the software:

• Pop-In Mode:  In this mode, you edit items on top of the main window. The advantage of this is that it allows you
to see the items you are editing on top of other project items. It also allows you to align the new items you draw
with the existing ones.

• Pop-Out Mode:  In this mode, items are edited in a separate window, and you do not see other project items behind
it. While this mode is generally used less often, it can be useful to isolate the items being edited and remove
needless clutter from the screen.

The following controls are used to switch between Pop-In and Pop-Out editing modes.

If you are using Pop-In mode, you can click this icon at the top-centre of the screen to switch to
Pop-Out mode.

If you are using Pop-Out mode, you can click this icon at the top-right of the screen to switch to
Pop-In mode.

The controls available are the same regardless of the editing mode, although the layout of these controls is slightly
different. The following three buttons are always present:

https://youtu.be/G2V8QG05gs4
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• OK:  Clicking this button applies the changes you have made to the project and finishes editing.
• Apply:  Clicking this button applies the changes you have made to the project but allows you to continue editing.
• Cancel:  Clicking this button cancels the changes you have made to the project and finishes editing.

Adding a Site Plan
Site Plans can be added from PDF, CAD, and Image. To load a new site plan, click on Plans in the menu bar and then
select either Add PDF file, Add CAD file or Add Image File. You will be prompted to choose the file you want to
load. If you opt for a PDF file with multiple pages, you will be prompted to select the specific page to load.

After this, the following window will be displayed:

The different elements of this window are summarised below. They are described in more detail in subsequent
sections.

• ① This is where you can rename the site plan. Useful for distinguishing plans, when adding multiple pages.
• ② This is where the position and scale of the loaded image, in the real world, will be specified. You can also

choose to crop the image if you wish. This option is particularly useful for drawings with title blocks that you
want to remove.

• ③ Moving the transparency slider to the far left, makes the site plan totally invisble, while a slide to the far right
may conceal the topography underneath. Anywhere in between provides varying levels of visibility, allowing the
user to see a mix of the topography and plan.

• ④ This is where you can opt to hide colours from the site plan, ensuring that the cut and fill is not obscured.
• ⑤ Greyscale Filter option converts an image's colours to a grey range, with black or white at the extremes. This

would be present below the 'Hide Colours' box but is not available for CAD (e.g. dxf) site plans.

The settings for image position, crop, and the transparency are described further in the following sections.
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Setting the Position and Cropping
A site plan is positioned into its real-world location by adjusting it's scale, moving it's position, and rotating the image
as required. Alternatively, if you have two known co-ordinates on the image, you can define them, and the software
will scale, rotate and move the image to match these two co-ordinates.

The following controls are used to define the image's position:

• ① Move: Re-position the site plan to a new point or coordinate.
• ② Rotate: Rotate the image to align to a north vertical orientation.
• ③ Scale: By Ratio or by Length.
• ④ Align to two points: Move, Rotate and Scale in one move. Align two known points to real-world coordinates.
• ⑤ Crop: Reduce the size of the site plan and remove any unnecessary information.
• ⑥ Clear Crop: Set the site plan back to the original size.

Two informative videos:  Scale, Rotate, Move  covers scaling techniques
like 'By Length' and relative positioning. Cropping, Colours and
Transparency explains how to remove unwanted site plan imagery.

Move

This option allows you to move the site plan image by specifting a point on the image and then entering its real-world
coordinates. This is useful if there is a known co-ordinate defined on your image. It is important to remember that you
should move the image after you have done any necessary scaling and rotation, as these operations will alter positions
on the image.

Once you have selected this option, follow the instructions below:

Move Prompts

https://youtu.be/-8Trm6ZEe_k
https://youtu.be/gM7rSiBGYmc
https://youtu.be/gM7rSiBGYmc
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1. Select a base point to move

Define the point which you want to move by clicking once in the preview.
2. Type or click on screen to set the new position of the base point

Type the location (X and Y) that you want this point to be moved to. Alternatively, you can click on the screen to
set the new point position to another screen location.

Rotate

This option enables you to rotate the image by defining a north reference angle on the image. This is useful if you
want to display your image in an orientation different from its inherent one. For example, aligning it with a north-
vertical orientation when there is a north arrow on the image that is not vertical.

Once you have selected one of this option, follow the instructions below:

Rotate Prompt

1. Draw the north arrow (base to tip)

Draw a line on the preview to define your reference north angle. Click once to start drawing the line and a second
time to finish.

Scale

Scale a PDF or Image file.

You can do this with one of two methods.

Select 'Scale' then select the option you wish to use ('By Ratio' or 'By Length')

1. 'By Ratio' (PDF only):

a. Specify the new scale

Type the new scale for the PDF, such as 1:100, or 1"=25'. Click OK to complete the scale.

--OR--

2. 'By Length': Specify a length on the image and then type its length in the real world. This option is particularly
useful if you have a defined length on your image. E.g. a scale bar or a marked dimension.

a. Draw a line along a scale guide or any other known length

Draw a line on the preview to define your reference length. Left-click once to start drawing the line and a
second time to finish.

b. Enter the new length

Type the value of the length you want the reference length to be scaled to.

c. Defined Scale Ratio

The on-screen prompt will state: "The length you have defined is close to a defined scale ratio". Now choose to
scale by an exact length or keep the exact length you specified.
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Scaling a CAD file

CAD files are automatically imported to the scale they are created. However, there are occasions when the file
imports in diffferent units to the ones you require.

Select 'Scale' and then choose the unit you want to scale the site plan in.

Align to Two Points

This is the easiest option if you have two co-ordinates defined in the image. It allows you to specify the two points on
the image and then type their co-ordinates in the real world. The software will then scale, move and rotate as required
to match these two points.

Align to Two Points Prompts

1. Select the first point to align

Define the position of the first reference point by clicking once in the preview.
2. Type or click on screen to set the new position of the first point

Type the location (X and Y) that you want the first point to be moved to. Alternatively you can click on the screen
to set the new position to another screen location.

3. Select the second point to align

Define the position of the second reference point by clicking once in the preview.
4. Type or click on screen to set the new position of the second point

Type the location (X and Y) that you want the second point to be moved to. Alternatively you can click on the
screen to set the new position to another screen location.

Once you have completed the instructions on the prompts, the prompt will disappear and the image will be adjusted as
you have specified.
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Crop

You can crop the site plan to remove any unnecessary borders and titles. This is done by clicking on the Crop ⑤
button. You will be prompted to draw the crop rectangle on the screen. You can clear this crop by clicking on Clear
Crop ⑥ button, and you can always adjust it by clicking again on the Crop ⑤ button in the editing site plans window.

Stitching Site Plans
When stitching multiple plans within a single project, it's crucial to ensure alignment across all plans.

Here's a step-by-step guide to complete the process:

1. Scaling the First Plan:

Before stitching additional plans, ensure that the initial plan is appropriately scaled. This sets the foundation for
accurate alignment.

2. Verifying Scale Compatibility:

When incorporating a second plan, double-check its scale to match the first plan (Hold down the M key and move the
cursor along a known length). Consistency in scale is vital for seamless integration.

3. Orientation Alignment:

If the site plans share the same orientation, using the 'Move' control suffices for alignment. For varying orientations,
the 'Align to Two Points' feature may be more suitable, albeit requiring a few additional steps.

The selection between 'Move' and 'Align to Two Points' depends on the specific requirements of your project.

4. Move:

Procedure

• • Activate the Move on page 35 tool.
• Click on the initial location on the site plan you want to move. This is likely to be a 'Match Line'.
• Do a second click on the desired destination site plan ('Match Line') where you want to plan to move to.

5. Align to Two Points:

Procedure:

• • Select the Align to Two Points on page 37 tool.
• Click on the initial location on the site plan you want to move. This is likely to be the one end of a 'Match

Line'.
• Do a second click on the desired destination site plan (the end of a 'Match Line') where you want to plans to

line up.
• Repeat the process for a second location (the other end of a 'Match Line'), optimising alignment.

Overlaying Site Plans

When overlaying multiple PDF/Image plans within a single project, it's crucial to ensure alignment across all plans.

Here's a step-by-step guide to complete the process:

1. Scaling the First Plan:

Before adding and overlaying multiple plans, ensure that the initial plan (existing terrain) is appropriately scaled. This
sets the foundation for accurate alignment.

2. Verifying Scale Compatibility:
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When you add a second plan, double-check its scale matches the first plan (Hold down the M key and move the
cursor along a known length). Consistency in scale is vital for seamless integration. If the scales differ, you will need
to scale each plan independently.

3. Orientation Alignment:

If the site plans share the same orientation, using the 'Move' control suffices for alignment. For varying orientations,
the 'Align to Two Points' feature may be more suitable, albeit requiring a few additional steps.

The selection between 'Move' and 'Align to Two Points' depends on the specific requirements of your project.

4. Move:

Procedure:

• • Activate the Move on page 35 tool. Go to Plans → Edit next to the site plan you want to move.
• Click on the initial location on the site plan are moving.
• Do a second click on the desired destination site plan where you want to plan to move to.

5. Align to Two Points:

Procedure:

• • Select the Align to Two Points on page 37 tool. Go to Plans → Edit next to the site plan you want to move.
• Click on the initial location on the site plan you want to move.
• Do a second click on the desired destination site plan where you want to plan to move to.
• Repeat the process for a second location, optimising alignment.

What if I need to overlay CAD and PDF site plans?

In this scenario, you should import the CAD site plan first. This is because the CAD plan will be scaled and
positioned so you can then use the Move and Align to Two Points tools to position the PDF to over the CAD plan.

Learn about moving and aligning site plans in our videos Scale, Rotate,
Move and Align to Two Points Tutorial.

Setting the Transparency
When a new site plan is added to a project, the white colour is removed. This means that site plan documents with a
white background will have the background removed, leaving just the line work for take-off or reference. If needed,
you can remove the default colour to restore a white background or add different colours to be removed.

In instances where a site plan has various coloured areas, you may need to set multiple 'Mask Colours', one for each
colour you wish to remove. There is a 'Tolerance' slider to control how strict the colour matching is.

https://youtu.be/-8Trm6ZEe_k
https://youtu.be/-8Trm6ZEe_k
https://youtu.be/ba0gkDM_src?t=638
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Since the site plan will be displayed on top of the existing terrain and earthworks, it is necessary to give it
transparency, allowing visibilty through the plan to the layers below. In many cases, the default transparency settings
will be suitable. However, when the transparency needs to be adjusted, this can be achieved using the controls shown
below.

These controls work together as follows:

• ① This slider can be used to define the overall transparency to apply to the whole image. When set to its
minimum (the default) there will be no overall transparency. As the slider is moved to the right, the overall
transparency will increase until at the maximum value the image will completely disappear.

• ② These controls can be used to completely mask out specified colours. By default, there is a mask on white,
which is the background colour for most drawings. Additional mask colours can be set by clicking 'Add New
Colour' and then clicking a point on the preview to select a colour. Mask colours can be changed by clicking into
the colour box and selecting a new colour on the screen, and they can be removed by clicking 'Remove'.

It is also possible to remove colours which are similar to the selected mask colour(s) by adjusting the tolerance
slider. If the slider is set to its minimum, only exact matches on the mask colour(s) will be removed. As the
tolerance value is increased more colours will be removed in a widening band around the specified colour(s).
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The Cropping, Colours and Transparency video explains how to crop
your site plans, remove colours, and adjust transparency for a cleaner,
more customised view of your project.

Setting Visibility
There are multiple ways to display a site plan in a project.

Default: By default, site plans display in 2D and 3D views.

Turn site plans on and off:

There are multiple functions which turn site plans on and off.

1. Click 'Plans' in the top menu, hover over your site plan and click 'Hide' to turn off. Alternatively, go to 'Plans' →
left-click the eyeball next to your plan name to switch off and on.

2. When a site plan is switched On in the 'Plans' menu, in each phase you have the option to display in 2D and 3D
views. In the 'Display' panel, click on the 'Site Plan Visibility' button and select 'No Site Plans' to turn off and 'All
Site Plans' to switch on and have site plans showing in 2D and 3D. This Site Plans toggle is also available in the
pop-out editing window.

3. Only 2D on - When a site plan is switched On in the 'Plans' menu, in the 'Display' panel, click on the 'Site Plan
Visibility' button and select 'Site Plans in 2D' views. This will turn 3D site plans view off.

4. Only 3D on - When a site plan is switched On in the 'Plans' menu, in the 'Display' panel, click on the 'Site Plan
Visibility' button and select 'Site Plans in 3D'. This will turn 2D site plans views off.

Site Plan Surfaces

Having selected your plan(s) to be displayed in 2D and 3D, or just one of the dimensions. You can then choose which
surfaces of your project the site plans are displayed in. Consider your project to be made up of 3 surfaces:

• ① Proposed - the area of disturbance within a phase
• ② Ground - the existing or ground level of a phase
• ③ Surround - the coloured background area outside of the model, which may show your site plan, where there is

no ground or proposed topography.

https://youtu.be/gM7rSiBGYmc
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To display your site plans on the different surfaces go to the 'Plans' menu and hover over your listed site plan to reveal
the list and the option to 'Move Down' (Move Up will appear as an option once the site plan has been moved below
"--Proposed--").

Below are the three view options:

All surfaces on: The
site plan is at the top
of the list, above "--
Proposed--" so displays
on all the surfaces of the
project.

Ground & Surround:
The site plan is between
"--Proposed--" and "--
Ground--" so displays
on the Ground and
Surround surfaces. (Not
the Proposed)
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Surround only: The
site plan is below the
"--Ground--" so only
shows on the Surround
surface, i.e. not on
the model (Not the
Proposed or Ground).

The Layering in 2D and 3D video quickly demonstrates options for
adding, modifying, and viewing site plans.

https://youtu.be/j5of3829kO4
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Construction Phases

Topics:

• Overview

Construction phases allow you to break your project into multiple phases of
work. For example, a typical earthworks project would have a strip/reduce
phase and a bulk earthworks phase as a minimum.

Understanding the concept of construction phases is key to making full use of
Kubla Cubed
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Overview
In Kubla Cubed the tabs ① that run along the bottom of the screen are referred to as 'construction phases' or just
'phases'. Elevation and Measurement elements that you create will be added to the selected phase only, the volumes
shown on the screen relate to the selected phase only rather than an accumulation of all volumes in the project.

The first phase always contains the existing ground, any number of subsequent proposed phases can be created.

There are two main reasons to create more than one proposed phase:

1. It allows earthworks volumes and measurements to be separated into logical sections (e.g topsoil, bulk earthworks,
paving).

2. It allows a new set of calculations to be completed using the proposed elevations of the previous phase as the new
ground.

The second item is particularly important. Consider a backfill operation: in the first proposed phase you define a
trench (Phase 1) which cuts into the existing ground and in the second proposed (Phase 2) you fill the trench in.

In Kubla Cubed, each phase conducts calculations on two surfaces: a ground surface (derived from the previous
phase) and a proposed surface (defined with earthworks elements). Within a single phase, there is no way to calculate
backfilling the trench because placing earthworks over the trench would overwrite that section of the proposed rather
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than calculate a separate 'fill' volume. Earthworks elements within a single phase are combined to create a single
proposed surface; they do not produce cut\fill volumes from intersecting with each other.

Instead, in this scenario, we must create another phase, effectively baking the result of the trench cut into the ground
of the next phase. The ground of the new phase will inherit the proposed from the previous phase, so it is now
possible to calculate backfilling the trench as part of a separate operation. Other common scenarios that require this
approach include the completion of topsoil stripping or demolition before iniating bulk earthworks.

To add a new construction phase, click on the + button ① and type a name for the new phase. If you want to delete or
rename a construction phase, right-click on the tab, and a menu will appear ② with these options.

To move a phase one place left or right, you can use the right-click menu. You can also drag and drop phases by
pressing the left mouse button down on a phase and moving the pointer to the new position while keeping the mouse
button down until it's in the drop position.

In our video  Understanding Construction Phases & Calculation Order, 
we discuss two critical concepts crucial for mastering the program.

https://youtu.be/d2h-P-7fLyo
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6
Elevation Elements

Topics:

• The Elements Panel
• Calculation Order
• Side Batters
• Absolute Elements
• Relative Elements

Kubla Cubed provides multiple options to define earthwork levels. Some
thought has to be given to the best earthworks elements to use in any given
scenario. When required, a number of elements can be used together to create
the proposed earthworks. Earthworks elements can be divided into two groups
regarding how their elevations are defined :

• Absolute Elements:  These elements are defined by explicit levels. The
Platform, Slope, Path, Feature Surface and Triangle Surface all fall under
this category. If they intersect with another element and are lower in the
calculation order, they will effectively overwrite the element below.

• Relative Elements: The next type are Relative Elements. The Reduce,
Raise, Trench and Berm elements come under this category. For these
elements, you do not input a level but instead a depth or height by which
to adjust the existing ground or the level already defined by elements
lower in the calculation order. If these elements intersect with other
elements lower in the calculation order, they do not overwrite them,
instead, they will adjust their level up or down.

Whenever designing a proposed surface by combining multiple earthworks
elements, it is essential to ensure that you are confident you have defined the
level you intended. To check, hover the mouse cursor over various points on
your designed surface to ensure the proposed Z value is what you expected.
Please see the section on the cursor label for more information.
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The Elements Panel
Each phase in a project contains an 'Elevations' panel. This is where earthworks elevation elements such as Platforms,
Slopes, Paths and Feature Surfaces can be added to the project. The Elevations elements in a panel are combined to
create a single proposed surface within a single phase.

Elevations Element Panel

① Add a new element - This opens the Element Menu.

② Delete an element - Deletes the selected element from the project.

③ Disable and Enable an element - Excludes or includes the element from the volume calculations.

④ Move an element in the calculation order - The arrows move the elements up and down the order.

Adding Elements

New elements can be added to the 'Elevations' panel by clicking on the + symbol ①. You will be presented with the
following list of elements that you can add:
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• Platform

The Platform element adds a specified area with a specified elevation to
the site, i.e. a flat area. This is most commonly used for defining building
pads and retention ponds. For more information see Platform Element.

• Slope

The Slope element adds a specified area with a specified slope to the site.
This is most commonly used for access ramps and run-offs. For more
information see Slope Element.

• Path

The Path element adds a path of a specified width with a specified
centreline to the site. This is most commonly used for access roads and
trenches. For more information see Path Element.

• Feature Surface

The Feature Surface element adds a surface defined with elevation
'features' (outlines, contours, break-lines and points). This is most
commonly used for take-offs such as those required by contractors for
bidding purposes. For more information see Feature Surface Element.

• Triangle Surface

The Triangle Surface element is used to define a surface using a
triangulation imported from another file. This is most commonly used to
import data from other programs which support triangulations (TINS).
For more information see Triangle Surface Element.

• Reduce

The Reduce element removes a specified thickness of material from
a specified area of the site. This is very commonly used for stripping
topsoil from the existing ground. For more information see Reduce
Element.

• Raise

The Raise element adds a specified thickness of material to a specified
area of the site. This is most commonly used for paving. For more
information see Raise Element.

• Trench

The Trench element adds a trench of a specified width with a specified
centreline to the site. This is most commonly used for utility trenches,
etc. For more information see Trench Element.

• Berm

The Berm element adds a berm of a specified width with a specified
centreline to the site. This is most commonly used for embankments,
dikes, etc. For more information see Berm Element.

Once you have selected an element you will be able to start drawing its boundary or centreline points in the design
area. Left-click to place a new point, Right-click or press Enter to complete the creation of the element. If you want
to cancel the operation entirely, hit the Esc key. When adding new elements the Backspace key can be used to undo
the last placed point if a mistake has been made.

Renaming Elements

After an element is created, it is a good idea to give it a relevant name so it can be identified in the report (e.g.
Building Pad 1 or Car Park). To do this just double click on the name of the element and then over-type.
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Editing Elements

• Selection : Elements can be selected by left-clicking on the title bar in the earthworks panel or by left-clicking on
there boundary or centre lines in the design area. Multiple elements can be selected by holding down Ctrl whilst
making the selection. To deselect an element you can right-click on it.

• Edit Mode : If you double click on an element it will enter into 'edit mode', the properties of the element will be
exposed and you will be able to edit the definition points of the element in the design view. To exit 'edit mode'
double left-click in empty space in the design view.

• Definition Points : When an element is in 'edit mode' the definition points of the boundary or centreline can be
changed. In the design view left-click on a point and drag it to the desired position. A point can be deleted by
using the Delete key. New points can be inserted by selecting a line and hitting the Z key. Points can also by
edited directly in the point list in the element properties. Clicking on the top-left corner of the point list allows all
the points to be copied using the menu command or Ctrl+C. Likewise a list of points can also be pasted into the
point list from another program by clicking on the top-left corner and using menu paste command or Ctrl+V.

• Notes on Point Snapping : When creating or editing the definition points of a earthworks element it is possible
to snap the points to other element definition points or to defined grid positions. To access the point snapping
options click on the Edit menu and then the Snap Points. Here you can toggle snapping to boundary points and
grid points as well as setting the interval and origin point of the grid used for snapping.

Properties

For information on the individual element properties refer to the relevant sections for each element.

Amending the Calculation Order

You can change the order of elements in the list by selecting an element and using the up down buttons ④. The order
of earthworks becomes critically important when two or more earthworks intersect. The calculation order can change
the way that the proposed surface is built and thus change the cut & fill estimate of a project. For more information
refer to the calculation order section of the user guide.

Copying & Pasting

It is often useful to copy and paste elements, this can be done using Edit menu commands or the keyboard shortcuts
(Ctrl+C, Ctrl+V). You can copy and paste in the same phase to duplicate an element or copy and paste to move
elements to different phases. See Copy and Paste on page 96.

Deleting Elements

Elements can be deleted by first selecting them and then clicking on the X button at the top of the Elevations panel ②.
(image above)

Disable and Enable Elements

Elevation Elements can be toggled between enabled and disabled by first
selecting them and then clicking on the power symbol button at the top of
the panel ① (left). Disabled elements are greyed out and have their names
struck through ② (left).

• Disabling an element has the same effect as temporarily deleting it, with
the advantage that it does not need to be re-entered. Disabled elements
will be excluded from the volume calculations, 2D and 3D displays, and
the calculation order. As with deleting, any element dependent upon
a disabled element will have its dependency set to “auto”. Disabled
elements may also be edited; however, none of the changes will take
effect until enabled.

• Enabling an element will reverse the disabling process and restore the
element to its normal status.
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• Selectively disabling and enabling elements provides flexibility in
managing the display and can be useful in identifying the cause of
calculation errors.

Calculation Order
Note that the calculation order is only important if you have earthworks elements which intersect at different
levels.

In Kubla Cubed, it is possible to have intersecting earthworks elements.
However, this can introduce a complication since it must be specified
whether the level in the intersection region will be controlled by one element
or the other. This is dictated by the 'calculation order' - in effect the order
that the earthworks elements are 'built' within the software.

Consider the following example, of two 'cut and fill' earthworks elements
(see image below). If one element has a level of +10m and another is at
+20m and they intersect, then what is the level of the resultant area where
they intersect? In Kubla Cubed , the answer is that it will be the level of the
element which is lower in the calculation order.

Note:  Changing the calculation order may affect elements other than the
one selected. For example, a Reduce element 'Reduce_1' which has 'Depths
From' set to a Platform called 'Platform_1'... if 'Platform_1' is moved to
the bottom of the list, 'Reduce_1's depth will be set from the next Absolute
element above it.

The image below illustrates the example described above. These two elements intersect at different levels, and they
are both in 'cut and fill' mode. If the element at +10m is above the element at +20m in the calculation order (left
image), then the higher element will fill over the top of the lower element. However, if the calculation order of these
two elements is reversed (right image) then the lower element will instead cut material out of the higher one.
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Mastering the program requires Understanding Construction Phases
& Calculation Order.These concepts are studied in context through
scenarios and demos in the video.

Side Batters
One powerful feature of Kubla Cubed is its ability to automatically generate side batters, the slope between the design
ground levels and the existing ground. This is particularly crucial in projects where the batter angles can be quite low,
such as coastal projects, and the volumes within these batters can represent a significant portion of the total volumes.

For each element, you can set the Side Batter ① to 'Off', 'External', or 'Internal' (limited). Then set the ratio ②. The
Side Batter, set as a ratio of vertical to horizontal, determines the angle of the side slopes on an element. It is set to a
default of 1:1.

• Side Batter - External (default): Outward slope, exceeding the defined boundary.
• Side Batter - Internal: Inward slope from boundary.
• Side Batter - Off:  Element joins ground with vertical sides.

However, instead of turning side batters 'Off', side batters of 1:0.01 are often recommended and more reliable.
When multiple elements are side-by-side, they are easier to join if they have side batters set to 1:0.01. In practical
terms, they are more or less the same thing. However, we have encountered problems related to vertical areas in
the triangulation, so we use this trick to replace them with as steep a slope as possible. In most cases, this prevents/
resolves triangulation issues.

Set Side Batter Cut & Fill Independently

By default, cut and fill ratios are linked. When either the cut or fill is set, the other one automatically updates to the
same ratio. The double arrow ③ between the two provides independent setting, allowing for different ratios. Left-
click on the arrows to toggle on and off.

This is particularly useful in scenarios like rock excavation, where the cut requires a steep side batter, while the soil
fill needs a gradual slope.

Impact of Side Batter

The images below shows how the side batter impacts the cut and fill volume for 6 identical circle platforms. In
this example, all of the circle boundaries are identical in shape, with either a cut or fill of 3 metres. In the 2D view
(below), the incline lines show the direction of the external and internal side batters. This is something to bare in mind
when altering the side batter settings.

https://youtu.be/d2h-P-7fLyo
https://youtu.be/d2h-P-7fLyo
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The 3D view (below), emphasizes the varied results based on the style of the side batter.

When to use External Side Batters?

This is the default and is frequently used for most elements.

When to use Internal Side Batters?

Commonly used when you know the extent of a boundary and need to excavate into it. For example, a pond or open-
cast mine.

When to turn Side Batter's Off?

Vertical side batters are commonly used for topsoil/site strips, when the reduction is relatively small. As mentioned
earlier,they are used when there are elements side-by-side to enable clean joining without intersecting side slopes. A
notable use case is a housing project when you have building pads, garages, and driveways are in close proximity.

Absolute Elements
Platform, Slope, Path, Feature Surface & Triangle Surface, are all absolute element types.



 | Elevation Elements | 56

Absolute elements are those that are specified to a fixed datum. For instance, elevations that are specified from Mean
Sea Level (MSL) are considered absolute elevations in Kubla Cubed. On a typical site plan, most hard landscape
elevations are marked with absolute elevations. Operations like topsoil strip and re-spread will often be described with
relative elevations, but they are frequently noted in project documentation rather than on the plan itself.

Absolute elevation elements offer various methods of specifying elevations. The 'Platform' element is specified with
a single value as it represents a horizontal plane. The 'Slope' element, also a plane but inclined, can be defined with
three points or an incline arrow. The 'Feature Surface' elevations are defined with a number of elevation features
(contours, break lines and points), and the Triangle Surface elevations are taken from the imported triangles.

In contrast to relative elements, absolute elements do not have a ‘Depth From’ or ‘Heights From’ field, but they do
include an 'Offset' option. Offsets allow you to move all the points in an element by a set amount, utilised to adjust
to subgrade variations in certain workflows. Elements defined with absolute elevations cannot adjust elevations from
preceding elements in the calculation order, unlike relative elements. Absolute elements explicitly define the proposed
level, completely overriding all previous elements in the calculation order when they intersect. This capability can
be highly advantageous, allowing projects to be built up in different layers. For example, one element may be used
to specify general elevations, and additional elements can be added with more detail in specific critical areas without
having to snap the boundaries together.

Platform Element

The Platform element is used to add an area with a fixed elevation to the site. This element is most commonly used
for building pads.

The properties that are exposed for the platform element are summarised below.

• Boundary

The Boundary Edit button provides access to the editor where the
definition points can be defined for the outline of the platform area.

• Level

This is the level that the platform area should be (subject to any offset
defined below).

• Mode

This is used to specify if the element should have Cut, Fill or both. Most
commonly Cut & Fill will be specified.

• Offset

The offset option is mostly used to add construction thicknesses by
specifying a negative offset. The options are Off, Z or it allows you to
offset the entire surface in X,Y and Z. This is useful for accommodating
for a construction thickness or finding a balance.

• Side Batter

The Platform boundary is joined to the ground by side slopes. The side
batter (set as a ratio of vertical to horizontal), dictate the angle of these
slopes. You can set the side batter to either External or Internal and
specify different side batter angles for side slopes that cut into the ground
and for those that fill into it. Turning side batter off will result in the
Platform being joined to the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.
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This video provides an overview of the Platform element's options
for defining a fixed, flat area of proposed ground Proposed Levels -
Platform Element

Slope Element

The slope element is used to define a specified area with a uniform incline. This element is most commonly used for
access ramps, sports pitches and run-offs.

The properties that are exposed for this element are summarised below.

• Boundary

The Boundary Edit button provides access to the editor wherein the
definition points can be defined for the points which define the outline of
the slope area.

• Define By

This option selects the controls you use to define the slope incline and
elevation. The '3 Points' option can be used to define the plane of the
slope. '3 Points & Offset' allows you to accommodate for a construction
thickness. The other options are 'Arrow' and 'Arrow & Offset. Using the
arrow, you can specify a single elevation and an incline angle to define
the slope or two elevations and allow the software to calculate the incline
angle for you (for more details see below).

• Level

This table specifies the points with levels that define the slope.

• Incline

This shows the ratio of the incline after creating a slope. Or input the
ratio required.

• Mode

This is used to specify if the element should have Cut, Fill or both. Most
commonly Cut & Fill will be specified.

• Offset

The offset option is mostly used to add construction thicknesses by
specifying a negative offset. The options are Off, Z or it allows you to
offset the entire surface in X,Y and Z. This is useful for accommodating
for a construction thickness or finding a balance.

• Side Batter

The slope boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal), dictate
the angle of these slopes. You can set the side batter to either External or
Internal and specify different side batter angles for side slopes that cut
into the ground and for those that fill into it. Turning side batter off will
result in the slope being joined to the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

https://youtu.be/80zkfJQfnc0
https://youtu.be/80zkfJQfnc0
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Option 1: Three Points

This option allows you to define a slope using three points. Three points explicitly define a plane. This option is more
technical than the other options but can be useful if there are three elevations clearly marked on the drawing to use as
reference.

Option 2: Arrow Base

This option allows you to define the slope with a single elevation at the base, an incline angle and a direction
specified by the arrow. The arrow position can be controlled by dragging the tip, shaft or base of the arrow. The length
of the arrow has no effect on the slope with this option.

Option 3: Arrow Tip

This option is similar to using and arrow and a base elevation but instead of specifying the elevation at the base of the
arrow you specify one at the tip. Again, the arrow position can be controlled by dragging the tip, shaft or base of the
arrow. The length of the arrow has no effect on the slope with this option.

Option 4: Arrow Both
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This option allows you to set the elevation of both the base and the tip of the arrow leaving the software to calculate
the incline angle for you. This can be especially useful when creating ramps from one area to another when you know
both elevations. You can move the arrow at the base and the incline of the ramp will adjust accordingly.

Proposed Earthworks : The Slope Element  video demonstrates slope
creation by setting the incline with the arrow tool or via three values.
Learn how to build ramps, run-offs, and other sloping areas.

Path Element

The path element is used to define a path with a fixed width and defined levels. This element is most commonly used
for roads and trenches.

The properties that are exposed for this element are summarised below.

• Boundary

The Boundary Edit button provides access to the editor wherein the
definition points can be defined for the outline as well as the levels (or
depths) for the path.

• Width

This is the width of the path.
• Mode

This is used to specify if the element should have cut, fill or both. Most
commonly cut and fill will be specified.

• Offset

The offset option is mostly used to add construction thicknesses by
specifying a negative offset. The options are Off, Z or it allows you to
offset the entire surface in X,Y and Z. This is useful for accommodating
for a construction thickness or finding a balance.

• Side Batter

The Path boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal), dictate the
angle of these slopes. You can set the side batter to either External or Off
and specify different side batter angles for side slopes that cut into the

https://youtu.be/o2iK6MAZfHY
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ground and for those that fill into it. Turning side batter off will result in
the Path being joined to the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

Estimate linear structures such as trenches, roads and causeways with
the  Proposed Earthworks : The Path video. For more complex roads,
consider using a Feature Surface with varying level outlines and a centre
line (defined by a break-line), or contours.

Feature Surface Element

The feature surface element is used to define a complex surface specified by outlines, contours, break-lines and
points. This element is most commonly used for take-offs such as those needed by contractors for bidding purposes.

The properties that are exposed for this element are summarised below.

• Features

The Features Edit button will open the take-off window so that you can
define the outlines, contours, break-lines and points which define this
surface. For more information on the options available in the take-off
window see Elements Panel

• Mode

This is used to specify if the surface should have cut, fill or both. Most
commonly cut and fill will be specified.

• Offset

The offset option is mostly used to add construction thicknesses by
specifying a negative offset. The options are Off, Z or it allows you to
offset the entire surface in X,Y and Z. This is useful for accommodating
for a construction thickness or finding a balance.

• Side Batter

The Feature Surface boundary is joined to the ground by side slopes.
The Side Batters on page 54 (set as a ratio of vertical to horizontal),
dictate the angle of these slopes. You can set the side batter to either
External or Internal and specify different side batter angles for side
slopes that cut into the ground and for those that fill into it. Turning side
batter off will result in the Feature Surface being joined to the ground
with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

Sometimes called a super element for its ability to produce the results
of any other element, the 'Feature Surface' is described in the video
Proposed Levels - Feature Surface .

https://youtu.be/_RCgOGvZ7p4
https://youtu.be/mTN17igeXHk
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Triangle Surface Element

The triangle surface element is used to add a triangulation into a project that has been originally created in another
program (or Kubla Cubed project). The triangles cannot be edited once they are added to the project, all triangulation
data needs to be imported from a file. The triangle surface supports importing data from LandXML (.xml), CAD
(.dxf, .dwg) and Kubla Project files (.kcp).

The properties that are exposed for this element are summarised below.

• Mode

This is used to specify if the surface should have cut, fill or both. Most
commonly cut and fill will be specified.

• Offset

The offset option is mostly used to add construction thicknesses by
specifying a negative offset. The options are Off, Z or it allows you to
offset the entire surface in X,Y and Z. This is useful for accommodating
for a construction thickness or finding a balance.

• Side Batter

The triangle surface boundary is joined to the ground by side slopes.
The Side Batters on page 54 (set as a ratio of vertical to horizontal),
dictate the angle of these slopes. You can set the side batter to either
External or Internal and specify different side batter angles for side
slopes that cut into the ground and for those that fill into it. Turning side
batter off will result in the triangle surface being joined to the ground
with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

The Existing Levels - Triangle Surface video offers a thorough study
of the Triangle Surface and importing TIN data into your project from
various sources. LandXML files, imported via the Triangle Surface, are
extensively covered in our video Working with LandXML Files (.xml).

Relative Elements
Reduce, Raise, Trench and Berm, are all Relative element types.

In Kubla Cubed, relative elements are those that are specified with heights or depths. For instance, a trench defined
as 2ft below the ground surface is characterised by a relative depth. The alternative form, ‘absolute elevations’ would
have elevations defined from a fixed datum (e.g., 156m from Sea Level). Typically, existing terrain is defined with
absolute elevations whereas proposed terrain can be defined with a combination or relative and absolute elevations.
For example, a topsoil strip is almost always defined with relative elevations (e.g. 1 ft topsoil strip), whereas building
pads are defined with absolute elevations (e.g. 245ft FFL).

Each element that is defined by depths has an inverted counterpart defined by heights. The Trench has depth values,
while the Berm has height values, both are defined by a centreline. Similarly, the Reduce element's opposite number
is the Raise element. You can specify heights in a depth element and/or depths in a height element, by using negative
values.

Relative elements all have a property called ‘Depths From’ or ‘Heights From’. This property allows you to specify
the surface to which the elevations are relative. An obvious choice is to make them relative to the ground surface,

https://youtu.be/NnfSjUdqOaw
https://youtu.be/I8Jf541JtH0
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meaning they will override each other in areas of intersection, with the element lower in the calculation order taking
precedence. However, having the elevations relative to ground is not always desirable. For instance, if you wanted to
reduce a slab level for a material thickness in a specific area, you would want the depths defined from the slab level,
not the ground. The ability to change what the depths/heights are relative to is extremely powerful, allowing you to
adjust the surface of lower elements in the calculation order, as well as the ground. In 'Depths/Heights From', you can
select 'Ground', the 'Previous Element' or a named element.

When the ‘Auto’ option is active, the option is dynamically set to the first absolute element above it in the calculation
order. If there aren’t any, it is set to ground. It can be conceptually confusing to have relative elements adjust each
other, especially for new users to the program, so the auto option ensures the relative elements adjust only from
previous absolute elements in the calculation order or ground if no absolute elements are found. The option is
dynamic so you can add and remove elements, and all the relative adjustments elements will update accordingly.

Reduce Element

The Reduce element is used to remove a fixed thickness of material from an area of the site. This element is most
commonly used for stripping topsoil at the start of a project and for making subgrade adjustments.

The properties that are exposed for the Reduce element are summarised below.

• Boundary

The Boundary button provides access to the editor where the definition
points can be defined for the outline of the Reduce area.

• Depth

This is the depth of material that you wish to remove from the Reduce
area.

• Depths From

This setting dictates from what surface the specified depths are relative
to. ‘Ground’ can be selected, or you can select the ‘Previous Element’
if you want the depths to be relative to the surface when the previous
element in the calculation order is built. You can also select a named
element. When the ‘Auto’ option is active ‘Depths From’ is dynamically
set to the first absolute element above it in the calculation order. If there
aren’t any, it is set to ground. The behaviour when ‘Auto’ is active is
desirable in most circumstances.

• Side Batter

The Reduce boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal) dictate
the angle of these slopes. You can set the side batter to either External or
Internal. Turning side batter off will result in the Reduce being joined to
the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

Topsoil Stripping demonstates using the Reduce element for topsoil
stripping operations and explains the importance of defining strip depths
in a separate phase to subsequent earthwork elevations.

https://youtu.be/m8MqXWZRdL0
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Raise Element

The Raise element is used to add a fixed thickness of material to an area of the site. This element is most commonly
used for adding paving or topsoil.

The properties that are exposed for the Raise element are summarised below.

• Boundary

Boundary button provides access to the editor whereby the definition
points can be defined for the outline of the Raise area.

• Height

This is the height of material that you wish to add from the Raise area.
• Heights From

This setting dictates from what surface the specified heights are relative
to. ‘Ground’ can be selected or you can select the ‘Previous Element’
if you want the heights to be relative to the surface when the previous
element in the calculation order is built. You can also select a named
element. When the ‘Auto’ option is active ‘Heights From’ is dynamically
set to the first absolute element above it in the calculation order. If there
aren’t any, it is set to ground. The behaviour when ‘Auto’ is active is
desirable in most circumstances.

• Side Batter

The Raise boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal) dictate
the angle of these slopes. You can set the side batter to either External or
Internal. Turning side batter off will result in the Raise being joined to
the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

Trench Element

The Trench element is used to define a linear path with a fixed width and defined depths. This element is most
commonly used for trenches.

The properties that are exposed for this element are summarised below.

• Centrelines

The edit button will open the take-off window so that you can define the
centrelines which define the Trench.

Note:  Depths are specified with positive values
• Depths From

This setting dictates from what surface the specified depths are relative
to. ‘Ground’ can be selected or you can select the ‘Previous Element’
if you want the depths to be relative to the surface when the previous
element in the calculation order is built. You can also select a named
element. When the ‘Auto’ option is active ‘Depths From’ is dynamically
set to the first absolute element above it in the calculation order. If there
aren’t any, it is set to ground. The behaviour when ‘Auto’ is active is
desirable in most circumstances.
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• Width

This is the width of the path.
• Mode

This is used to specify if the element should have cut, fill or both. Most
commonly cut and fill will be specified.

• Side Batter

The Trench boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal) dictate
the angle of these slopes. You can set different side batter angles for side
slopes that cut into the ground and for those that fill into it. You can set
the side batter to either External or Off. Turning side batter Off will result
in the Trench being joined to the ground with vertical sides.

Between the Cut and Fill ratios is a double-arrow button which, when
depressed, will synchronise Side Batters.

Estimate linear structures such as trenches, roads and causeways with
the  Proposed Earthworks : The Path video. For more complex roads,
consider using a Feature Surface with varying level outlines and a centre
line (defined by a break-line), or contours.

Berm Element

The Berm element is used to define a raised linear path with a fixed width and variable heights. This element is most
commonly used embankments.

The properties that are exposed for this element are summarised below.

• Centrelines

Edit button provides access to the editor wherein the definition points can
be defined for the outline as well as the heights for the Berm.

• Heights From

This setting dictates from what surface the specified heights are relative
to. ‘Ground’ can be selected or you can select the ‘Previous Element’
if you want the heights to be relative to the surface when the previous
element in the calculation order is built. You can also select a named
element. When the ‘Auto’ option is active ‘Heights From’ is dynamically
set to the first absolute element above it in the calculation order. If there
aren’t any, it is set to ground. The behaviour when ‘Auto’ is active is
desirable in most circumstances.

• Width

This is the width of the Berm.
• Mode

This is used to specify if the element should have cut, fill or both. Most
commonly cut and fill will be specified.

• Side Batter

The Berm boundary is joined to the ground by side slopes. The Side
Batters on page 54 (set as a ratio of vertical to horizontal) dictate
the angle of these slopes. You can set different side batter angles for side
slopes that cut into the ground and for those that fill into it. You can set

https://youtu.be/_RCgOGvZ7p4
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the side batter to either External or Off. Turning side batter off will result
in the Berm being joined to the ground with vertical sides.

Between the Cut and Fill is a button which (when depressed) will
synchronise Side Batters.

Estimate linear structures such as trenches, roads and causeways with
the  Proposed Earthworks : The Path video. For more complex roads,
consider using a Feature Surface with varying level outlines and a centre
line (defined by a break-line), or contours.

https://youtu.be/_RCgOGvZ7p4
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7
Measurement Elements

Topics:

• The Measurements Panel
• Count Element
• Length Element
• Area Element
• Volume Region Element
• Volume Region - Batch Create
• Cross Section Element

Kubla Cubed offers five distinct measurement elements that can be drawn on
screen to focus on specific parts of the model. Data related to these elements
can be viewed in the various exports, such as spreadsheet exports and reports.
Note, that there other measurement tools available, which are described in
separate sections.
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The Measurements Panel
Each phase in a project contains a measurements panel. This is where additional measurements, such as counts,
lengths, areas and cut\fill in specific regions, can be added to the project. There is no requirement to add any
elements to the measurements panel as a lot of data is reported in the standard report. However, some supplementary
measurements are often required in addition to the standard information.

Measurements Element Panel

① Add new element - This opens the Element Menu.

② Delete an element - deletes the selected element from the project.

③ Disable and Enable an element - excludes or includes the element from the volume calculations.

④ Move an element - the arrows move the elements up and down the order.

Adding Elements

New elements can be added to the measurements panel by clicking on the + symbol ①. You will be presented with
the following list of elements that you can add :
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• Count

The Count element allows you to record the position and number of
various groups of assets on the site. You can use a Count element to
record the position of manholes or count the number of trees. For
more information, see the Count Element.

• Length

The Length element allows you to measure distances on the site as
well as record assets that have a length property, such as kerbs and
fences. Length elements can be closed to measure perimeters. It is
worth noting that all earthworks elements report a boundary outline
perimeter in the input data summary so there is no need to trace a line
around any earthworks element. For more information see the Length
Element.

• Area

The Area element is used for measuring areas in the project. Areas
of earthworks disturbance are recorded in the estimation summary,
so there is no need to measure these. Area elements only measure 2D
areas, as if they were measured from a paper plan. They don't measure
the 3D surface area that can be found in the 'Estimation' report. For
more information, see the Area Element.

• Volume Region

The Volume Region element is used for reporting cut\fill in different
regions of a particular phase. It is worth noting that there is no
requirement to have any volume regions in a phase. If none are
defined, the 'Estimation' report will still show a breakdown by element
and results for all earthworks in the phase. For more information, see
the Volume Region Element.

• Cross Section

The Cross Section element is used for visualising a cut through the
terrain, displaying the existing and proposed terrain along the cross
section. The cross section can be viewed in the software, and is also
presented in some of the exports. For more information, see the Cross
Section Element.

When you have selected an element, you will be able to start drawing its boundary, centreline, or points in the design
area. Left-click to place a new point, right-click or press Enter to complete the creation of the element. If you want
to cancel the operation entirely, hit Esc key. When adding new elements, the back space key can be used to undo the
last placed point if a mistake has been made.

Renaming Elements

After creating an element, it is a good idea to give it a relevant name so it can be identified in the report (e.g.,
'boundary fence' or 'flower bed'). To do this, just double-click on the name of the element and then type over it.

Editing Elements

• Selection : Elements can be selected by left-clicking on the title bar in the earthworks panel or by left-clicking on
a elements boundary or centre lines in the design area. Multiple elements can be selected by holding down Ctrl
while making the selection. To deselect an element, you can right-click on it.

• Edit Mode : If you double-click on an element it will enter into 'edit mode', and the properties of the element will
be exposed. You will be able to edit the definition points of the element in the design view. To exit 'edit mode';
double left-click in empty space in the design view.
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• Definition Points : When an element is in 'edit mode', the definition points of the boundary or centreline can
be changed. In the design view, left-click on a point and drag it to the desired position. A point can be deleted
by using the Delete key. New points can be inserted by selecting a line and hitting the Z key. Points can also by
edited directly in the point list in the element properties. Clicking on the top-left corner of the point list allows all
the points to be copied using the menu command or Ctrl+C. Likewise, a list of points can also be pasted into the
point list from another program by clicking on the top-left corner and using menu paste command or Ctrl+V.

• Notes on Point Snapping : When creating or editing the definition points of a measurement element, it is possible
to snap the points to other element definition points or to defined grid positions. To access the point snapping
options, click on the Edit menu and then the Snap Points. Here, you can toggle snapping to boundary points and
grid points, as well as setting the interval and origin point of the grid used for snapping.

Properties

For information on the individual element properties, refer to the relevant sections for each element.

Amending the Order

You can change the order of elements in the list by selecting an element and using the up-down buttons ④. Unlike
the elevations panel where the order of the earthworks can change the proposed elevations, the order of measurement
elements has little consequence apart from changing which element shows on top if two intersect, or the order they
appear in export files. You may want to change the order of elements so similar measurements are grouped together.

Copying & Pasting

It is often useful to copy and paste elements; this can be done using Edit menu commands or the keyboard shortcuts
(Ctrl+C, Ctrl+V). You can copy and paste in the same phase to duplicate an element or copy and paste to move
elements to different phases. See, Copy and Paste on page 96.

Deleting Elements

Elements can be deleted by first selecting them and then clicking on the 'X' button at the top of the panel ② (image
above).

Disable and Enable Elements:

Measurement Elements can be toggled between enabled and disabled by first
selecting them and then clicking on the power symbol button at the top of
the panel ① (left). Disabled elements are greyed out and have their names
struck through ② (left).

• Disabling an element has the same effect as temporarily deleting it, with
the advantage that it does not need to be re-entered. Disabled elements
may also be edited; however, none of the changes will take effect until
enabled.

• Enabling an element will reverse the disabling process and restore the
element to its normal status.

• Selectively disabling and enabling elements provides flexibility in
managing the display. Measurement Elements do no impact the volume
calculations.
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Count Element
The Count element allows you to record the position and number of various groups of assets on the site.  For example,
you can use a Count element to record the position of manholes or count the number of trees. 

The properties that are exposed for the Count element are summarised below.

• Positions

The Positions Edit button provides access to the editor where Points can
be added/edited for the Count.

• Colours

Here, you can set the Main and Text colour of the Count element. This
can be useful for visually separating different Count measurements or
making them easier to see against the colours of the topography.

• Label Text

Customize the Count label, to display information most relevant to your
project. Select one or more options: Name (Count element name); Tag
Index (count feature index within the element); Tag (the descriptors you
may have given to each Count feature).

• Bracket Style

The bracket style allows you to change the style of the brackets enclosing
the item number. This can also be used to visually separate different
Count measurements in your project. You can set the bracket style to
'none' if you want to show the number without brackets.

The video  Count, Length and Area Measurements explains the 'Count'
measurement element, illustrating point placement and discussing the
value of these measurements.

Length Element
The Length element allows you to measure distances on the site as well as record assets that have a length property
such as kerbs and fences. 

The properties that are exposed for the length element are summarised below.

• Centrelines

Centrelines button provides access to the editor where definition points
can be defined for the centrelines which define the length.

• Colours

Here you can set the Main and Text colour of the Length. This can be
useful for visually separating different Length measurements or making
them easier to see against the colours of the topography.

• Label Text

Customize the Length label, to display information most relevant to
your project. Select one or more options: Name (Length element name);

https://youtu.be/7q09jGspbdQ?t=120
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Tag Index (length feature index within the element); Tag (the descriptor
optionally given to each Length feature); Length; Units.

The video  Count, Length and Area Measurements explains the 'Length'
measurement element, demonstrating how to measure between two
positions.

Area Element
The Area element is used for measuring areas in the project. Areas of earthworks disturbance are recorded in the
earthworks estimation summary so there is no need to measure these.  Area elements only measure 2D areas, as if
they were measured from a  paper plan.  They don't measure the 3D surface area that can be found in the earthworks
estimation report.

The properties that are exposed for the area element are summarised below.

• Boundary

The Boundary Edit button provides access to the editor where definition
points can be defined for the outline, which defines the area perimeter.

• Colours

Here you can set the Main and Text colour of the area element. This can
be useful for visually separating different Area measurements or making
them easier to see against the colours of the topography.

• Fill Style

The fill style allows you to fill in the area with different styles of
hatching. This can also be used to visually separate different Area
measurements in your project. You can set the fill style to none if you
only want to see the boundary lines of the measurement.

• Label Text

Customize the Area label, to display information most relevant to
your project. Select one or more options: Name (Area element name);
Tag Index (area feature index within the element); Tag (the descriptor
optionally given to each Area feature); Area; Units.

The video  Count, Length and Area Measurements explains the 'Area'
measurement, covering how to draw the boundary and use colour
hatching for clarity.

Volume Region Element
The Volume Region element is used for reporting cut/fill in different regions of a particular phase. It is important to
note that there is no requirement to have Volume Regions defined in a phase. If none are defined, the 'Estimation'
report will still display a breakdown by element and results for all earthworks in the phase.

https://youtu.be/7q09jGspbdQ?t=186
https://youtu.be/7q09jGspbdQ?t=227
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Intersecting regions are not allowed. This is to prevent potential confusion caused by cut/fill volumes being counted
multiple times in the same breakdown. Handling a region within a region involves first calculating the outer region
excluding the inner region and then separately calculating the inner region. Any areas not enclosed by a region will be
listed under ‘remainder’.

The properties exposed for the region element are summarised below.

• Define By

Dropdown options to choose how to define your region are:

• Boundary (default)

• Cut and Fill Range

• Height (enter value)
• Depth (enter value)

• Cut Range

• Lower Depth (enter value of least cut)
• Upper Depth (enter value of most cut)

• Fill Range

• Upper Height (enter value of most fill)
• Lower Height (enter value of least fill)

• Boundary

The Boundary Edit button provides access to the editor where definition
points can be specified for the outline, which defines the Volume Region.

The Volume Region Measurements video demonstrates how to draw
valid volume regions and explains how they are reported in the
spreadsheet export.

Volume Region - Batch Create
There are two established groupings of excavation/earthworks estimation ranges in Kubla Cubed. Currently, the
program supports two Royal Institution of Chartered Surveryors (RICS) standards: NRM2 and SMM7. To create a
standard batch of volume regions in a phase of your project, follow these steps:

1. Double-click on 'Measurements' to open the panel.
2. Click the '+' button and hover your cursor over the Volume Region option, to reveal the 'Batch Create' button and

click.
3. Select the standard you wish to use.

https://youtu.be/oTiAaocQm8g
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RICS NRM2 (2013+)

NRM2 - New Rules of Measurement

Use this tool to create Volume Region reports specified in NRM2 for different types of excavation and filling.

• By default, 'Excavation' and 'Filling obtained from excavated materials' are selected.
• Select the options you require volumes for and click OK.

• The regions will automatically generate with the results showing in the Measurements panel on the right-hand side
and the regions defined on the model with an orange and black dashed boundary (as shown in the image below).
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RICS SMM7 (< 2013)

SMM7 - Standard Measurement Methods

Use this tool to create Volume Region reports specified in SMM7 for different tups of excavation and filling.

• By default, only 'Excavation' is ticked.

• If you attempt to tick 'Filling' you will receive a pop-up message with the SMM7 guidelines and four options to
choose from. The message states:

SMM7 guidelines state that fill should be reported by 'average fill'. An average fill calculation requires a defined area,
so this calculation can only be completed if the site has been rationalised into discrete areas (e.g., planting boxes, grid
cells, phases of work, etc.).

Average Fill Solutions (SMM7 Guidelines)

This tool cannot be used to report by 'average fill'. However, there are several approaches that could be taken to report
average fill using tools available in Kubla Cubed:

[1] The element breakdown can give you an average fill of the element reporting areas.
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[2] You can manually trace volume regions to get an average fill in custom areas.

[3] Export to a grid and calculate average fills in each grid cell manually and sum cells accordingly.

Depth Band Solution (Not to SMM7 Guidelines)

[4] Alternatively, Kubla Cubed can report by depth bands in a similar way to SMM7 excavation and NRM2 Cut &
Fill. However, it should be noted that this does not adhere to the standards specified in the guidelines for SMM7 Fill.

• When you choose option [4], 'Filling' will be ticked, then click 'OK' to generate the regions.

Validation Failed

When two or more Volume Regions overlap, they will all be invalid. This is displayed in Kubla Cubed by the element
being highlighted in Red, with an error message of 'Validation Failed' written in the metadata field. No volumes are
calculated or reported for the regions that have this status.

The valid measurements will still show in the The Measurements Panel on page 68 and on the export reports/
spreadsheets. The errored element(s) will not be reported. To rectify this error, either diasble one of the elements that
has a duplicate region or delete it completely.

Cross Section Element
The Cross Section element is used for visualising a slice cut through the terrain, and displaying both the existing and
the proposed layers. The Cross Section can be viewed in the software, and also will be presented in exports.

The properties that are exposed for the Cross Section element are summarised below.

• Centrelines

The Boundary Edit button provides access to the editor where the
definition points can be defined for the points which define the cross
section.

• Graph

Click the View button to display the cross section graph.
• Reverse Direction

The direction that the cross section is viewing will be indicated by the
section arrows on the screen. You can reverse the direction by clicking
this button.
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When you click on the 'View' button, a screen will open, similar to the one shown below. You can use the mouse to
zoom in and out and pan around this section. As you move the mouse, the cursor will present the levels, and the cut/
fill information. It is worth noting that the sections presented in this view will use the vertical exaggeration from
the main window. If you find the section difficult to visualise because it is too flat, you can increase the vertical
exaggeration before viewing the section.

Measurements - Cross Sections demonstrates drawing long sections and
cross sections across a phase, before highlighting various viewing and
export options.

https://youtu.be/ZMbmlm0xA6o
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8
Editing Elements

Topics:

• Feature Types
• Adding New Features
• Adding Features Manually
• Adding Features from a PDF/

CAD File
• Adding Points from a Data File
• Editing and Deleting Features
• Group Selection
• Editing Tools
• Copy and Paste
• Triangle Surface

NOTE:  Elements can be edited in Pop-In or Pop-Out mode. For an
explanation of these modes see Editing Modes.

With the exception of the Triangle Surface, all elements are defined by a
collection of elevation features, drawn manually or loaded from a file (e.g.
CAD). The four elevation features are: outlines, contour-lines, break-lines,
survey-points, or a combination but always in that order.

After an introduction to the feature types (outlines, contours, breaks and
points) the remainder of the chapter covers how to import data, create it
manually and also update/edit.
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Feature Types
The elevation features may be named differently within some elements, however they have the same behaviours and
are recognisable by their icon and order. The feature surface has all four types of data, which makes it suitable as a
base example. Any combination of the following terrain features (where available) can be used to define the terrain:

Outlines

This element is used to define the outline(s) of the feature surface. There will almost always be
only one outline, but it is possible to define more than one to create several 'islands' of terrain. It is
also possible to create holes in the terrain by adding internal outlines.

There are also different types of Outline:

• i) Extrapolate from other Features (Default): Takes the levels from contained elevation features
that you have defined (e.g. contour lines and points).

• ii) Define Varying Levels: Allows you to set levels for the outline which vary at each point. This
can be used if you need maximum control of the surface outline elevations.

• iii) Define Fixed Level:  Allows you to set a single level for the outline, this is only used in very
unique scenarios.

• iv) Use Ground Levels:  Snaps the Outline elevations to the ground. (This can only be used with
a feature surface used to define proposed earthworks)

Contour Lines

Contour lines (or isolines) are used to define lines on the terrain with a fixed elevation

Break Lines

Break lines are used to defined lines on the terrain which have a varying elevation

Point Levels

Point levels are used to define the levels for individual points in the terrain area

The properties of each feature vary depending on the feature type, but they all have a 'Tag' which can optionally be
set. This is an identifier for the feature (akin to the feature's name), and it is used to help the user identify particular
features.
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This form includes three display buttons as described below:

• ① Pop in to Edit in Main Window This takes you back to the main editing and model window.

• ② Toggle Grid This button toggles the grid in the designer on and off.

• ③ Zoom to Extents This button zooms the designer to extents (i.e. frames all elements in the designer panel)
• ④ Zoom to Selection This button zooms the designer to selected features
• ⑤ Toggle Site Plan This button toggles the site plan in the designer on and off.

The rest of the controls on this form are used to add, remove and edit the terrain features. They are described in detail
in the following sections.

Learn to define boundary outlines in the video  Understanding Feature
Surface Outlines.

Adding New Features
Terrain features can be added either by drawing them manually on the designer screen or by loading them in from a
file. Outlines, Contour Lines and Break Lines can be loaded from PDFs (with vector data) and CAD files (.dwg, .dxf)
whereas Point Levels can be loaded from either a PDF (with vector data) CAD, or from an Excel or text data file.

https://youtu.be/HiTVcWfJI3E
https://youtu.be/HiTVcWfJI3E
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To add a new feature, select the feature type that you want to create ① and then click either Add Manually ② or Add
from File ③. If you add a feature from a file you will be prompted to select the file to open. The process to follow
after this is described in the following sections.

Adding Features Manually
The process, once you have clicked on the + button to add a new feature manually, depends on the type of feature you
have selected. In all cases, you draw the elements on the designer panel on the right of the screen.

• Outlines

When you choose to add an Outline, the following prompt will appear, providing two options to create outlines.

• Automatic outline: If you choose this option, the software will automatically create outlines based on the
features that you have defined. This process is analogous to wrapping a rubber band around the features that
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you have already defined to create an outline. You can adjust how much this 'rubber band' is 'sucked in' using
the tolerance slider bar.

• Draw: If you choose this option, you will draw an exact outline on the screen. You will be provided with a
four options to set the levels for this outline:

1. Extrapolate from other Features (Default): Takes the levels from nearby elevation features that you have
defined (e.g., contour lines and points).

2. Define Varying Levels: Allows you to set levels for the outline that vary at each point. This can be used if
you need maximum control of the surface outline elevations.

3. Define Fixed Level: Allows you to set a single level for the outline; this is only used in very unique
scenarios.

4. Use Ground Levels: Snaps the outline elevations to the ground (this can only be used with a Feature
Surface used to define proposed earthworks).

When you choose your preferred option, follow the steps to complete the outline. Once you have finished, you
will see the prompt below.

You can define a Tag for the Outline if you wish. Click 'Next' to draw another Outline, or 'Finish' to stop drawing
Outlines.

• Contour Lines

Draw each point of the Contour Line by left-clicking on the designer panel. Finish drawing the contour by right
clicking or by pressing the Enter key. The following prompt will appear:

You should type the level for the Contour Line into this prompt. You can also define a Tag if you wish. Lastly, if
the Contour Line is a closed loop you can click the Closed checkbox. Click Next to draw another Contour Line or
Finish to stop drawing Contour Lines. Note that the '...' before the 'Level' input box can be used to adjust the levels
you type. E.g. if all of your levels start from an elevation of 1000 you can click on '...' and input '1000+'. You can
then type, for example '26' into levels box and this will be converted into '1026'. This can save time in some take-
off scenarios.



 | Editing Elements | 84

• Break Lines

When you choose to add a break line, you will be prompted to click on the designer panel to define the first point's
position. Once you have done this you will see the following prompt.

You can define a level (Z) for the Break Line point and can also type precise X and Y values if you wish. If you
prefer, you can skip typing the level, and the software will interpolate it. This is useful if you have a detailed break
shape where the levels are only defined at a few locations.

If you leave point levels blank, the software will fill them in with the following logic:

• Wherever the Break Line crosses another line (e.g., a contour) a point will be added to the Break Line with the
same level as the crossing line.

• When crossing line points have been added, linear interpolation will be used along the Break Line to fill in any
missing levels.

Click 'Continue' to draw another breakline point or 'Complete' to finish drawing the Break
Line. Once you have finished drawing a Break Line, the following prompt will appear:

You can also define a Tag for the new Break Line if you wish. If the Break Line is a closed loop you can click the
Closed checkbox. Click 'Next' to draw another Break Line or 'Finish' to stop drawing Break Lines.

• Point Levels

Draw the Point Level by left-clicking on the designer panel. The following prompt will appear:

You should type the level for the Point Level into this prompt. You can also type X and Y values for precise
positioning. If you wish, you can type a Tag for the Point Level. Click 'Next' to draw another Point Level or
'Finish' to stop drawing Point Levels. Note the comment on 'Contour Lines' above regarding the '...' in front of the
level input box.

Adding Features from a PDF/CAD File
To extract vector data from a CAD.PDF file in Kubla Cubed:

1. Adding the PDF/CAD File as a Site Plan:

• Open Kubla Cubed and navigate to Plans → Add PDF File (.pdf) or Add CAD File (.dwg, .dxf).
• Choose the desired PDF/CAD file and click ‘Open’.



 | Editing Elements | 85

2. Scaling and Positioning the PDF File:

• Since PDFs are in printer space, you must scale and position the file as required.
• Use the Kubla Cubed tools to adjust the scale and position of the PDF accurately. SeeSetting the Position and

Cropping.
• CAD files are usually scaled; however, a quick scale check by holding down the 'M' button is recommended.

See Quick Measure Tool.
3. Selecting Elements and Adding Features:

• Click + button in Elevations and select elevation element type you wish to add.
• Choose the feature tab (Outlines, Contours, Breaks, Points) for importing.

• Click the 'Add from File' button located at the bottom-left of the editor panel.
• Select the embedded PDF file you previously added as a site plan.

Upon selecting a CAD (.dxf, .dwg) file or vector PDF, a "Load.." pop-up window will appear (shown below).

Please note that this window will exclusively extract features interpretable as the selected feature type, as follows:

• Outlines: Only closed lines will be displayed
• Contour Lines: Only lines will be displayed
• Break Lines: Only lines will be displayed
• Points: Only points will be displayed
• Centre Lines: Only lines will be displayed

4.  Importing Entities:

• A new "Load..." window will open, click ‘New Filter’ ①.

The CAD importer allows multiple selection filters. This means that if you have major and minor contours you can
have a filter for each rather than combined. Instead of filtering red and green lines with a width of 1 or 3, you can
filter red lines with a width of 1 and green lines with a width of 3. This allows for more precise filtering.

• Position the cursor in the Original window ⑦, left-click to start and finish highlighting the element you wish to
import.

• The selected lines/points will display in the ‘Extracted’ window ⑧. The number of points extracted displays in
grey and the if there are points/lines with no defined value the count will show in red.
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5.  Inspecting and Filtering Options:

• ③ Filter: Inspect and filter entities in the site plan file by clicking on the Layers, Entity Types, Line, Weights, Line
Types and Colours. Toggle on/off as needed; turned-off Layers etc. will not be imported.

• ④ Elevations: for setting elevations in CAD to a proxy ‘Not Set’ value (e.g -9999 or 0) which will then be
converted to ‘Not Set’ when imported into Kubla Cubed.

• ⑤ Cropping: Only want to extract part of a site plan? Crop an area in the Original window to remove any
unwanted data.

• ⑥ Modifications: Adjust the sliders to remove small outlines\lines and fix line gaps in the extracted data.
• ⑦ Show/Hide Layers: Click to see a list of layers in the file. Toggle on/off to show/hide the layers you require.

This makes locating a specific layer easier to find.
• ⑧ Entity Status Display: Displays the total number of extracted entities, including a breakdown of entities

with levels and those without levels based on the current Elevations settings as detailed in bullet point ④.
Use the checkboxes to toggle the inclusion of entities with levels and entities without levels in the output.

• ⑨ Export: Export the original file as a CAD file or Export the extracted data as either CAD or CSV.
• ⑩ Simpify: With large data sets, you can opt to reduce the detail by clicking the simplify button and adjusting the

tolerance slider in the pop-out window.
• ⑩ Finish: Click once ready to import the data showing in the extracted window. This will close the window and

show the data in the model view.
• ⑪ Cancel: Click to close the window without importing data.

6.  Editing Entities in the Model View

After clicking Finish in the 'Load...' window, your entities will import into the Kubla Cubed model window where you
can edit further.

• Outlines, Contours, and Break lines can be edited using tools found in the Tool Menu (Hammer/Spanner).
• Use these tools for Joining, Splitting, Setting Multiple Elevations, and Ordering features. Refer to Editing Tools on

page 90 for details.
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Learn to import contours, points, and a poly-face mesh in our Working
with CAD Data (.dxf, .dwg, .dgn) video, which also covers CAD export.

Adding Points from a Data File
Once you have selected an excel or text file the following window will appear. In the case of an excel file, the 'File
Format' section will not appear, as this is only used for defining text file formats.

If you are using a text file it is necessary to define the file format with the controls on the left. In many cases the
file will immediately show correctly in the previewer. However, if you have an unusual file format you may need to
amend the details of the file format on the right side as follows:

• ① File delimiters Specify what character is used to delimit the fields in your file. Files are typically tab, comma or
space delimited, but any character can be specified here by clicking Other and typing in the text box.

• ② Treat consecutive delimiters as one Specify whether several consecutive delimiters in a file line should be
treated as one, or if these should be treated as several fields with empty values.

• ③ Decimal Point Specifies whether your file uses a point or a comma to denote a decimal point. This is used to
deal with different conventions in different parts of the world.

• ④ Text Qualifier Specifies the character that is used on either side of a text field in the file, if your file contains
text fields.

There are also some controls which can be used to adjust the levels (Z values) in the file:

• ⑤ Offset Levels by - If the points in your file are offset from the vertical datum you want to use then you can
specify it here.

https://youtu.be/Br-YsVH8V74
https://youtu.be/Br-YsVH8V74
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• ⑥ Invert Levels - Kubla Cubed uses upwards-positive convention for levels. If your file uses upwards-negative
convention, then you can use this option to invert the values in your file so that they are suitable for Kubla Cubed.
This option is mostly used for hydrographic surveys, which often report depths as positive values.

Finally, you must specify which columns in your file represent the X, Y, Z and Tag (if it contains tags) values for the
data. This is done by clicking on the column header in the data preview ⑦ and selecting 'X', 'Y', 'Z' or 'Tag' from the
drop-down. You can also specify 'Ignore' if that column contains data which is not relevant.

In the video Kubla Cubed Tutorial | Importing Point Files
(.xyz, .csv, .xls) we look at importing point files to define both the
existing and proposed terrain using a feature surface.

Editing and Deleting Features
Features can be selected in two ways - either by clicking the element on the list to the left of the window or by
clicking on the feature in the designer panel. Note that only the current feature type is selectable in the designer panel.
For example, in the example shown below only contour lines ① are selectable in the designer panel. See Group
Selection for more information.

Once features have been selected, they can be deleted by clicking on the Delete ② button.

There are additional tools: Join, Split, Offset, Set Multiple Elevations, Sort, which can be found when selecting the
Tools ③ button. Find out more in Editing Tools.

A feature can be edited by double-clicking on it in the sidebar or designer panel. When you do this, the feature will be
expanded in the sidebar, exposing its properties so that you can change them. You can now edit this feature either by
typing new values into the side panel or by dragging points and lines in the designer panel ②. Points can be added to
or removed from lines by clicking on the ± button in the table ①. You can also add a new point to split a section of a
line, by selecting the section and clicking Z.

https://youtu.be/-R3RhI15QKQ
https://youtu.be/-R3RhI15QKQ
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Group Selection
Being able to select multiple features at the same time speeds up editing. The below images show two methods of
group selection.

Multiple features can be selected by holding down the
ctrl key and clicking on several items.

A block of features can be selected by holding down the
shift key whilst clicking on the first then last item.

Click your left-mouse button on a single feature, without pressing a key, to deselect all other features.
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Editing Tools
Line editing tools—Join, Split, Offset, Set Multiple Elevations, and Sort—assist with the definition of lines.
Availability is dependent on the element being edited and the type of feature used within. They are accessible from
the Tools menu (shown below) within the element editor.

Join Tool

The Join Tool can connect two or more contour break-type lines together and supports the joining multiple elevation
features in one operation. This functionality is useful for fixing contour line gaps, such as text labels imported from
a CAD file. When working with contour lines, and more than one elevation is included within the selection, the tool
defaults to choosing the highest elevation, alternatively this value can be edited as needed.

How to use the Join Tool

Once your lines have been added (whether through imported data from a file or drawn manually), the process
involves selecting the lines that need to be connected, previewing the planned join, and then confirming the operation.

1. Select the Join tool from the Tools menu.
2. Choose the lines you wish to be joined.

a. Click on the first line you wish to join.
b. Hold down the Ctrl key and select the

second (and seubsequent) lines which you
want to merge into one line.

3. Press the 'Continue' button when ready to
proceed.

4. Verify that the preview is indeed what you
want (the lines will be joined and highlighted in
green)

5. Review and adjust the level (contour type lines
only) and edit as needed.

6. Press the 'Finish' button

Join tool in preview; inset the join tool selected as found in the tools menu.

Why won't my lines join?
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If only one line is selected, or if one or more of the lines are closed, the join operation will fail, and the validator will
display an error message identifying the issue. This is recoverable once the necessary selection changes have been
made; there is no need to restart the process. If the operation needs to be canceled, clicking on the 'X' in the top right
of the black strip along the bottom will cancel the Join operation.

See the Join tool in action in our quick tip video Join Two Lines.

Split Tool

The Split Tool can divide a break-line or contour line into multiple lines, either at selected points or selected sections.
This functionality is particularly useful for editing lines that may have been incorrectly joined. When a segment is
chosen within the line to be split, the new lines generated will exclude the selection. Alternatively, when a point is
selected within the line to be split, the newly created lines will both have an end point at the split point.

How to use the Split Tool

After the lines have been added (via imported data file or drawn manually) select the line you want to split. This can
be done either by selecting a line from within the feature list window or by selecting a line within the main window/
model view. A preview will display each new line in a different colour. The split can be confirmed or discarded by
clicking the 'Finish' button or the 'X' in the black wizard.

1. Select the line you wish to be split.
2. Locate and click on the point or section

of the line where the split is needed (it
will become highlighted).

3. Select the Split tool from the Tools
menu#.

4. Press the 'Continue' button when ready
to proceed.

5. Verify that the preview is indeed you
want.

6. Press the 'Finish' button.

Why won't my lines split?

Closed lines are not supported. If the line is closed, the split will fail, and the validator will display an error message
identifying the issue. This is recoverable once the necessary selection change has been made; there is no need to start
again. If the operation needs to be canceled, click on the 'X' in the top right of the black strip along the bottom, will
cancel the Split operation.

Offset Tool

The Offset Tool is used to create a new line placed at a user-specified offset (relative distance and relative elevation)
from the original line. Users are prompted to enter a point indicating which side of the original line the offset should
be placed. While the elevation represents a relative adjustment along the Z-axis, the distance relates to adjustments
within the XY plane. This functionality proves particularly beneficial for generating footpaths alongside roads. The
tool extends its support to outlines, contours, and break-lines.

https://youtu.be/a541W-YCyiY
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How to use the Offset Tool

1. Begin by adding at least one original line (outline, contour or break), either through file-imported data or by
drawing it manually.

2. Select the line from which you wish to create the offset, either from the feature list window or by directly clicking
within the main window/model.

3. Proceed to the 'Tools' menu and select 'Offset' (see image above). Upon selection, the mouse cursor icon will
transform into a crosshair, indicating the need for the user to pinpoint the side of the original line where the new
offset line should be placed.

NOTE: If the single click (with crosshair) is within a closed line, the offset line will also be closed, provided the
entered distance does not prevent a valid offset. In all other scenarios, the offset line will be outside the original. If
the preview does not display the desired outcome, the Z adjustment and distance can be modified until the 'Finish'
button is pressed.

4. Subsequently, the Wizard will prompt for the input of the relative Distance and relative Z (Z Adjustment) from the
original line. For instance, if the elevation of the original contour line is 200m, a Z adjustment of 20m will set the
elevation of the offset line to 220m. The distance denotes how far the new offset line will be positioned from the
originally selected line.

5. Once valid data is entered into the distance and Z adjustment inputs, a preview of the new offset line will be
displayed. The preview will dynamically update after each alteration to the distance or Z adjustment, Rounded
Corners, and Delete Original, although it requires the user to deselect the input box for the updates to take effect.

6. Confirm the changes by pressing 'Finish'. Alternatively, discarding the offset can be achieved by pressing the 'X' in
the wizard.

What are Rounded Corners

Rounded Corners are useful if you want to soften corners or buildings or contours. The image below shows the
original contour ①, the offset contour before rounding ② (on the left) and the offset line after the corners have been
rounded ③ with the slider slid to it's maximum (right).
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Delete Original Line

If you only require the new line, tick 'Delete Original'. This is useful if you want an outline offset and no longer need
the original line.

See the Offset tool in action in our quick tip video Offset a Line.

Set Multiple Elevation (SME) Tool

Contour lines (or isolines) are used to define lines on the terrain with a fixed elevation. When manually tracing
contour lines, a fixed elevation is added after completing the line. However, when extracting contours from a PDF or
importing from a flattened CAD file, there are no Z (level) values within the data; therefore, you need to add these
elevations. It is acknowledged that this can be time-consuming, so the SME tool was built to set the elevations of a
group of contour lines, making the process considerably faster!

How to use the SME Tool

The SME tool works quite differently from the Join and Split tools with regards to selection. After selecting the SME
tool from the Tools menu, place a point (left-click) just before the first line to be included in the range. Then, move
the mouse and subsequently place a second point beyond the first and second line in the range. You can either right-
click to finish or continue moving and clicking to add a multi-point line. The drawn line will identify the lines to be
included.

Once the range line has been created (after right-click) the start elevation, contour interval and slope direction
(ascending/descending) can be set. After editing these values as required, press 'Continue'. A preview will then
highlight the contours lines with a gradient green shading to highlight the elevation differences. If the preview is
acceptable, press 'Finish' to accept the proposed changes.

1. Select the SME tool from the menu.
2. Define the Range: Use your mouse's left button to draw a line from just before the first contour to the final

contour, ensuring your line intersects all of the contours in the group you want to set. Lift the left button and then
press it down again if you want to have a range line that is not straight. Right click to finish the line.

https://youtu.be/E5T8R-zMFho
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3. Set the 'Start' (elevation value of the first contour line e.g., 200). Then, add the 'Contour Interval' (difference
between each contour e.g. 1) and choose whether the difference is ascending or descending. Click 'Continue'.

4. Review the selected lines and Press the 'Finish' button.
5. New contour elevations have been added to the list on the left-hand side and to the contours themselves.

Above(clockwise from top left): SME tool location, drawing the range, accepting/editing default start elevation and interval, preview of changes.

Closed lines are supported. If the operation needs to be canceled, click on the 'X' in the top right of the black strip
along the bottom to cancel the SME operation.

Defaults for the Starting elevation, contour interval and whether the slope is ascending/descending are set based on
the first two contour lines in the selection.

The Set Multiple Elevations (SME) video demonstrates how to use the
SME tool in Kubla Cubed for fast contour elevation adjustments.

Sort Tool

When manually adding or importing features (outlines, contours etc.) to an Elevation Element (Feature Surface,
Platform Reduce, etc.), they will be imported in accordance with the source file, without any specific order, such as
by height. The Sort tool organises the list of features within an Elevation Element into ascending or descending order,
either numerically by Elevation or alphabetically by Tag.

Using Sort

The sort option is available by pressing the 'Tools' button when editing any element.

https://www.youtube.com/watch?v=mp3_Us4W5zE
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1. Select the Sort tool from the menu.

1. Select the type of sort by clicking the drop down and
choosing:

a. Elevation
b. Tag

2. Select the Order type:

a. Ascending
b. Descending

3. Press 'Sort' button

The list of features will update on the left of the screen, according to the options chosen.

Sort By Elevation
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The Sort tool is useful for locating zero and 'not set' values which are interspersed in a long list of set values after
importing features. For example, when ordering in ascending value, all the zero and 'not set' values will be sorted to
the top of the list, or to the bottom of the list when ordering by descending value.

When ordering features with a range of elevations (e.g., feature surface break lines) in ascending order , the sorting
will be based on ascending minimum elevation range values, whereas ordering by descending order will sort by
descending maximum elevation range values.

Sort by Tag

Sorting features alphabetically by Tag in ascending order will assist in finding a specific named feature within a long
list. This can be useful when grouping features by tag name.

Undo Sort

The original ordering of newly sorted features can be undone using undo (Ctrl+Z) but the sorted feature ordering will
be preserved when the project is saved.

Copy and Paste
It is often useful to copy and paste elements; this can be done using Edit menu commands or the keyboard shortcuts
(Ctrl+C, Ctrl+V). You can copy and paste in the same phase to duplicate an element or copy and paste to move
elements to different phases.

Which features can you copy and paste to another?

This table shows the features you can copy and paste to another. Generally, lines can be copied to lines (as long as the
"Is Closed" option is ticked) and only points can be copied to points.

Copy/Paste to: Outlines Break-lines Contours Centre-Lines Lengths Points

Outlines Yes Yes Yes Yes Yes No

Break-lines If closed Yes Yes Yes Yes No

Contours If closed Yes Yes Yes Yes No

Centre-Lines If closed Yes Yes Yes Yes No

Lengths If closed Yes Yes Yes Yes No

Points No No No No No Yes

Triangle Surface
The triangle surface is defined by a group of interconnected triangles. You cannot define these triangles manually;
instead they need to be imported from a program that works with triangulated models sometimes. The surfaces are
sometimes referred to as Triangulated Irregular Networks (TIN), triangulations, polyface meshes and Digital Terrain
Models (DTM).

The triangulations can be imported from CAD files (.dwg, .dxf), LandXML (.xml) files and Kubla Project files (.kcp).
When importing from CAD files you need to select the layer that contains the polyface mesh objects, the polyface
mesh objects in the selected layer will then all be merged together and imported as a single object. The LandXML
and Kubla files work slightly differently as they do not have layers, instead you need to select the specific name of the
surface you wish to import.
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This form includes two sections:

• ① Select File Here you select the file that contains the triangulation you wish to import.
• ② Select Layer\Surface In this section you select the layer (with CAD files) or surface with LandXML and Kubla

Project files.

Note:  If you are loading from a CAD (.dwg, .dxf) file this form will also have a 'units' drop-down. This is required
because the units are not saved in the .dxf format, so you need to specify them when loading the file

The video Existing Levels - Triangle Surface comprehensively covers
the Triangle Surface and how to import triangle data.

https://youtu.be/NnfSjUdqOaw
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9
Defining Existing Ground

Topics:

• Existing Defined with Points,
Contour Lines and Break-Lines

• Existing Defined with Triangles
• Existing Boundary Outline
• Lidar and Photogrammetry data

After importing and scaling site plans (if there are any) the next stage of a
cut and fill project is to define the existing ground. Existing ground can be
defined from a number of different sources. A simple stockpile project may
involve importing the existing ground from survey points stored in a text
file; a more complicated scenario could entail extracting existing contours
from an embedded PDF file's vector data. Existing take-off can be very time
consuming so it is worth using CAD data or extracting data from PDF vectors
if at all possible.

Existing elevations are usually defined with contour lines or points. In this
scenario the feature surface can be used to define your existing. If importing
from a different project that supports the creation of TINS you can also use a
Triangle Surface to import a TIN directly.
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Existing Defined with Points, Contour Lines and Break-Lines
Most existing surfaces are defined by points or contour lines. Break-lines are sometimes used in the existing to define
hard edges along existing buildings, roads, etc. Tracing elevations from a site plan is a workflow that has been around
since the very earliest volume estimating software. Early software required input from specialist digitisers and then
later with on-screen take-off. It is still possible to trace existing elevations in this way and in fact is a skill that all
users need to master. However, with the right data there are much faster ways of defining existing by importing
directly from files. Options for defining elevations in the existing are listed below with full descriptions following
thereafter:

Option 1: Importing from Point Files (.xyz, .csv, .txt)

Option 2: Importing from CAD Files (.dwg, .dxf)

Option 3: Importing from PDF Vectors (.pdf)

Option 4: Tracing from Site Plans

Option 1: Importing from Point Files (.xyz, .csv, .txt):

Point files are created during a topographic survey. They are a very simple format consisting of a text file with X,Y
and Z co-ordinates separated by a special character (e.g. a comma). They can be imported into a 'Feature Surface'
by selecting the 'Point' tab and selecting ‘Add from File’. Using point files is very fast and accurate as the points are
usually raw survey data. However, the point files do not support break-lines meaning that detail in regard to hard
edges cannot be imported efficiently.
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An existing surface being created from a point file

Option 2: Importing from CAD Files (.dwg, .dxf):

CAD files can contain all the necessary data to create a detailed surface in a few clicks. They may contain points,
breaks, boundary outlines and contours. Within a CAD file, you can logically separate different entities into their own
layers so you can have the contours in ‘Proposed Contours’ and ‘Existing Contours’, making it easy to select what
you need during the import process.

However, even though a CAD file has the potential to perfectly describe a surface with contours, points and breaks,
there is no guarantee this will be the case. Various issues in a CAD file can make importing difficult. For instance,
entities may be enclosed in a block, contours being represented by dashes, or entities may lack Z values, causing them
to be imported at 0 (zero) elevation. Kubla Cubed provides tools to resolve these problems, and in general, a CAD file
is usually the optimal file format to work with.

To extract vector data from a CAD file in Kubla Cubed:

1. Adding the CAD File as a Site Plan:

• Open Kubla Cubed and navigate to Plans → Add CAD File (.dwg, .dxf).
• Choose the desired CAD file and click ‘Open’.

2. Scaling and Positioning the CAD File:

• CAD files are usually scaled; however, a quick scale check by holding down the 'M' button is recommended.
See Quick Measure Tool.

3. Selecting Elements and Adding Features:

• Click + button in Elevations and select elevation element type you wish to add.
• Choose the feature tab (Outlines, Contours, Breaks, Points) for importing.

• Click the 'Add from File' button located at the bottom-left of the editor panel.
• Select the embedded CAD file you previously added as a site plan.

4. Import Entities:

• A new window will open, click ‘New Filter’
• Position the cursor, left-click to start and finish highlighting the element you want to import.
• The selected lines/points will display in the ‘Extracted’ window
• Use the options at the top of the window to filter the extracted data to your requirements.
• Repeat step 5 as required.
• Click 'Finish'.

For more details on the import window, see Adding Features from a PDF/CAD File on page 84
5. Edit Entities

• Outlines, Contours and Break lines, can be edited with the editing tools, found in the Tool Menu (Hammer/
Spanner), use these when you need to Join, Split, Set Multiple Elevations and Order your features. See Editing
Tools.

However, there are instances when processing CAD data takes so long to process it may be easier to revert to tracing
from the site plans.

Option 3: Importing from PDF Vectors (.pdf)

Unlike CAD files, PDF files do not contain technical metadata and are a poor option for transferring geo-technical
information. However, their widespread use in the industry is due, in part, to the fact that they can be read by anyone
without a CAD software product. For this reason, there is a benefit to being able to extract vector data directly from
PDF files, as PDF files contain vector information. If this data can be extracted it can save a lot of time in tracing.

To extract vector data from a PDF file in Kubla Cubed:
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1. Adding a PDF File as a Site Plan:

• Open Kubla Cubed and navigate to Plans → Add PDF File (.pdf).
• Choose the desired PDF/CAD file and click ‘Open’.

2. Scaling and Positioning the PDF File:

• Since PDFs are in printer space, you must scale and position the file as required.
• Use the Kubla Cubed tools to adjust the scale and position of the PDF accurately. SeeSetting the Position and

Cropping.
3. Selecting Elements and Adding Features:

• Click + button in Elevations and select elevation element type you wish to add.
• Choose the feature tab (Outlines, Contours, Breaks, Points) for importing.

• Click the 'Add from File' button located at the bottom-left of the editor panel.
• Select the embedded PDF file you previously added as a site plan.

4. Importing Entities:

• A new window will open, click ‘New Filter’
• Position the cursor, left-click to start and finish highlighting the element you want to import.
• The selected lines/points will display in the ‘Extracted’ window
• Use the options at the top of the window to filter the extracted data to your requirements.
• Repeat step 5 as required.

Contour lines extracted from a vector PDF file

For more details on the import window, see Adding Features from a PDF/CAD File on page 84

5. Edit Entities

• Outlines, Contours and Break lines, can be edited with the editing tools, found in the Tool Menu (Hammer/
Spanner), use these when you need to Join, Split, Set Multiple Elevations and Order your features. See Editing
Tools.

However, there are instances when extracing PDF vector data takes so long to process it may be easier to revert to
tracing from the site plans.



 | Defining Existing Ground | 103

Option 4: Tracing from Site Plans

Tracing elevation features from site plans can be very slow, however, there are some situations where there are no
alternatives and so it can be used as the method of last resort. For instance, if the site plan is a very poor-quality scan
or a CAD file does not contain data compatible with Kubla Cubed’s data importer, than tracing is a good alternative.

As an estimator you can choose to be selective in regard to what data to trace. For instance, if there are many contours
you could decide to only take off every other one or even just the major contours. However, this decision comes down
to the estimator's judgement as to whether the increased accuracy of the extra data is worth the extra time in tracing it
all.

Existing Defined with Triangles
In Kubla Cubed, it is possible to define an existing surface with triangles rather than with contour lines, points, and
break-lines. Typically, you would do this if you had used another piece of software to define a TIN surface already
and don’t want to have to define the surface again in Kubla Cubed. You can also export TINs of any phase of Kubla
Cubed to define as an existing surface of a new project. This allows you to break up very large projects or to compare
different options in different projects.

With this approach, you first add a 'Triangle Surface' rather than a 'Feature Surface' from the 'Elevations' menu.

Triangle surfaces can be imported either from a TIN defined in a LandXML file (.xml) or a polyface mesh defined in
a CAD file (.dwg, .dxf).

The video Existing Levels - Triangle Surface comprehensively covers
the Triangle Surface and how to import triangle data.

https://youtu.be/NnfSjUdqOaw
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Existing Boundary Outline
In a 'Triangle Surface', the boundary of the site is derived from the boundary of the triangles. However, when defining
existing ground with a 'Feature Surface', you need to define your own boundary. You can define a boundary with
‘Varying Levels’ whereby you input levels along the boundary outline yourself for maximum control. Alternatively,
a ‘Fixed Level Outline’ can be used if all the levels along the boundary are the same. However, the outline type most
frequently used is the ‘Extrapolate Outline', which derives its elevations from the elevation features contained within.

When starting new projects, it can seem like a good idea to define the existing boundary to the proposed area of
disturbance. In other cut and fill software often there is one fixed boundary used by both the existing and proposed
elevations. However, in Kubla Cubed there is a more sophisticated design. There is nothing wrong with fixed
boundaries per se, but it is not recommend. It is a bit similar to painting in that ideally, you need a canvas that
provides plenty of space for the painting subject; you don’t need to cut the canvas closely to where you intend the
painting to be.

The disturbance area of a Kubla Cubed project is controlled with the boundaries of the proposed elements not
the existing, and there are a number of reasons why having more existing surface they you need is advantageous,
including:

• Visualisations look nicer if the proposed works are placed in context of the surrounding topography, rather than
appearing to be floating in space.

• If the proposed design changes at a later date, the existing boundary does not need to be amended to accommodate
an expansion of the disturbance area.

• The extrapolate outline, as it is calculated, not explicitly defined, sometimes needs to be corrected by adding
elevation features inside the boundary. This is much easier to manage if the existing is larger than the proposed.

Existing with contextual data (left) compared to just the area of disturbance (right)

Lidar and Photogrammetry data
The use of drones, aeroplanes and boats to capture topography is becoming more and more popular. As the cost
and software\hardware improve, the speed and accuracy these types of surveys provide is becoming increasingly
compelling. Lidar (Light Detecting and Ranging) surveys use a laser to read the surface elevation. They are usually
mounted on boats or aeroplanes and can penetrate through light foliage and water. Photogrammetry is frequently
used by drones. The drones take 1000s of photographs of the site at different positions. These photographs are then
loaded into a computer, and by analysing the parallax effect of the images in a sequence an elevation surface can be
generated.

Both these processes produce data that can be loaded into Kubla Cubed as a point cloud. The one problem is that the
data sets tend to be very large in sizes often they can be 10 million points in size. Kubla Cubed users can, in theory,
convert this data into TINs and analyse the volume difference; however, memory, graphics and, processor limits will
start to be hit. Therefore, Kubla Cubed has a built in point reduction algorithm. If you import a large dataset, you
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will get a message asking you if you want to reduce the point cloud. If you select yes, you will get the point thinner
window, as shown below:

Note:

Currently, it is recommended that the maximum point cloud at which the software becomes difficult to operate is
80,000 for a modern laptop and 150,000 for a modern desktop PC.
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Topsoil Stripping

Topics:

• Reducing a Topsoil Strip by
Specified Depths

• Excluding Internal Areas from a
Strip

Often, at the beginning of an earthworks project, the first operation will be
to strip the site of topsoil. Topsoil will typically contain a far higher level of
organic material, usually including a sod/turf layer; in an industrial context,
it will contain a higher level of contamination (nails, glass, oil etc.). It is
removed separately for reasons of material reuse and soil stability.

A topsoil strip entails excavating an area by a set depth. For instance, you
may strip the entire site by 20cm. This is fairly easy to complete in Kubla
Cubed with the ‘Reduce Element’.

The two most important most important things to remember are to have:

1. Stripping calculation completed in its own distinct phase.
2. Earthwork operations that are to be completed after the strip, defined in

subsequent phases.

There can be earthwork challenges, including a requirement to reduce
different areas by different amounts and to exclude internal areas form a strip
(e.g. there is an existing building or tree on the site which is to be preserved).
Within this chapter, we will look how Kubla Cubed can model both of these
scenarios.
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Reducing a Topsoil Strip by Specified Depths

Create a Reduce Element for your Topsoil Strip

When you create a Reduce element you either trace or import an outline and then set the depth value. Essentially, this
is all you need to complete a topsoil strip operation.

Stripping the Entire Site

If you want to strip the entire site, you can simply draw the boundary beyond the extents of the existing ground
surface. However, this work-flow is not recommended. We suggest having more existing ground than the disturbance
area of your site as it produces better visualisations and makes it easier to spot errors at the disturbance area
boundaries.

Strips in Different Areas

If you want to complete strips in different areas, a Reduce element allows you to define multiple outlines, as long as
they do not intersect with each other. However, a single Reduce element can only have a single depth value. If there is
requirement is to strip different areas by different amounts then multiple Reduce elements should be used.

Adjusting Side Batter

The side batter of topsoil strips are usually quite steep, so to reflect this, it might be a good idea to adjust the side
batter angle from the default of 1:1 to something like 1:0.01 or even turn it off completely.

Create a New Phase

After the topsoil strip has been defined, it is worth reiterating that you need to create a new phase in order to calculate
from the strip level to another level (e.g. formation/subgrade level). If you overlaid a Platform or Feature Surface over
the top of the Reduce element in the same phase, the elevations from those elements would override the elevations of
the strip (see Calculation Order). This is not what we want; we want those elevations to be calculated from the topsoil
strip level so another phase is required to complete this operation.

What Happens when Reduce Elements Intersect?
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If Reduce elements overlap, they will override each other. Where they intersect, the depth in the lower element in the
calculation order will take precedence. This can be used to your advantage if there are two adjacent Reduce areas or
an internal Reduce area. Instead of snapping the individual areas together, you can override them and decide which
depths are used in the intersecting areas by changing the calculation order. This works as a Reduce element has the
‘Depths From’ property set to ‘Ground’ by default if there are no absolute elements above in the calculation order. It
is not recommended to change these options from default or use absolute elements in a strip phase so the behaviour of
Reduce elements overriding each other is consistent.

Excluding Internal Areas from a Strip
It is sometimes necessary to exclude internal region from a topsoil strip. This might be the case if there is a tree or
an existing building foundation in the middle of the site. The suggested way of doing this is to edit a reduce element
and create an outline within the outline that defines the boundary. The system will treat an internal outline as an inner
boundary effectively ‘punching out’ the inner area and excluding it from the reduce operation. You can define as
many exclusion areas as you need with additional outlines.

The Topsoil Stripping video demonstrates using the Reduce element for
topsoil stripping operations and explains the importance of defining strip
depths on a separate phase from subsequent earthwork elevations.

https://youtu.be/723o0q2lbAM
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Demolition

Topics:

• Breaking Out Concrete Areas
• Milling Paved Areas
• Calculating the Volume of

Demolished Materials

If a proposed construction project is taking place on a site with existing
structures, then a demolition phase may be required. For projects on empty
land, no demolition calculations are needed. Alternatively, if the existing
levels have been surveyed post-demolition, no calculation is required in that
scenario either.

While the majority of demolition estimating falls outside the scope of a
volumetric analysis program like Kubla Cubed, the program can be useful in
analysing certain activates where an estimation of volume is required. Even
if these volume are not necessary, it is crucial to complete the demolition
phase to adjust existing elevations properly for use in calculating volumes in
subsequent phases.

Consider a project with a 400mm thick concrete foundation to be removed
during demolition. Without a phase that reduces that level, subsequent phases
calculating over that area will be inaccurate, as they will be calculating from
the pre-demolition level rather than post-demolition.

Demolition must be defined in its own phase. If earthworks elements are
placed over demolition areas in the same phase, they can override the
demolition levels, effectively making the demolition elements redundant.
Instead, demolition elements must be in their own phase so subsequent
operations are calculated from the demolition level rather than overriding it.
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Breaking Out Concrete Areas
Concrete areas often need to be broken up and removed before building works can proceed. Typically, this involves
reducing the level of an area to a specific elevation. For this activity, one or more platforms can be used to reduce to a
fixed level.

As this is an excavation-only activity, it is worth setting the ‘Mode’ to ‘Cut Only’. This means that the elements will
only calculate cut and not fill.

Milling Paved Areas
A paved area can be milled to remove a surface layer to reduce the level, then to reuse the material elsewhere in
the project or recycle it. For this operation, you need to reduce the ground by a set amount rather than to a set level.
Naturally, the ‘Reduce’ element is perfect for this, as it allows you to specify both the area and the depth you want to
reduce it by.
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Defining a section of road, milled to a depth of 200mm with a Reduce Element.

Calculating the Volume of Demolished Materials
Another scenario in which Kubla Cubed can be used, is if a demolition has taken place and you need to calculate the
volume of demolished materials that remains on site. Usually, different materials will be collected into different piles
called stockpiles. A survey can be done of the elevations of these piles and Kubla Cubed can be used to estimate the
volume of each stockpile. There is a chapter dedicated to stockpile estimating later on: Stockpile Volumes on page
141
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Bulk Earthworks

Topics:

• Bulk Earthworks - Overview
• Adjusting to Subgrade /

Formation Level
• Soft Landscape (Ponds,

Gardens, External Works, etc.)
• Hard Landscape (Building Pads,

Drives, Car Parks, etc.)
• Recreational Grounds (Golf

Course, Sports Pitch, etc.)
• Roads and Paths
• Retaining Walls

Bulk Earthworks is the operation that takes place after a strip or demolition
phase of a project. It is the process of building up or excavating to get to the
formation level or subgrade level specified on the construction plans. There
are different approaches required for different scenarios. In this chapter, we
will discuss some common scenarios and a recommended approach. However,
Kubla Cubed is a flexible 'do all' volumetric calculator. These suggestions
can be discarded if, through experimentation, you find a better approach that
works best for your workflow.
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Bulk Earthworks - Overview
When defining bulk earthworks, it is possible to utilise all the element types to create the proposed topography, or it is
possible to use just use one. The definition of bulk earthworks elevations usually requires quite a bit more thought and
planning than, for instance, the existing, strip or demolition phases which can be quite straight forward.

In regard to the best approach, it often depends on what data you have in your site plan. If you have a set of contour
lines defining smooth terrain, it would be best to use a 'Feature Surface' and use contour lines. However, if you have a
series of terraced areas, then a number of platforms might be appropriate. For a warehouse foundation, with a number
of ramps you could use some platforms and slope elements or define the whole thing in a 'Feature Surface' with
break-lines.

Adjusting to Subgrade / Formation Level
Most site plans do not have the subgrade level marked. Instead, they mark the final finished level (FFL) and have a
separate plan of surface material thickness. When estimating bulk earthworks, we need to calculate to the subgrade, so
we need to find a way of adjusting for the subgrade in our project.

Notes on Terminology : In some areas of the world, the term 'subgrade' is used, and in others 'formation level'.
There are also several different terms used to refer to the level you will be standing on when the project has finished :
'finished floor level', 'finished grade' and 'final floor level' are all used.

There is one issue that needs to be considered before starting, and that is how to approach the problem of elevations
being marked at FFL level on a site plan (this is almost always the case). In the bulk earthworks phase, you will want
to calculate to the formation/subgrade level not the FFL level, so we need some way of making these adjustments. In
general there are three approaches :

1. The calculator method (not recommended)

This method involves manually adjusting elevations using a calculator before input. This works, of course, however, it
is flawed. Imagine adjusting 30 contour lines by 600mm only to be told later that, after consideration, the engineer has
decided to use a different build up and changes it to 700mm. Going back and adjusting with a calculator again is very
time-consuming. The other issue with this method is that the elevations you look at on the plan don't match those you
input, which makes it hard to check. We therefore recommend two alternative methods.
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2. The Offset Method

The Offset Method is named such because we use the Z offset value that is available in all explicit absolute elements
to offset an element with a negative value to make the required adjustment to the finished level. The Offset options
found in the dropdown are 'Off,' 'Z', or it allows you to offset the entire surface in 'XYZ'.

This Offset Method works very well when the different areas of material thickness are represented by different
elements in a project. For instance, if you have four building pads represented by four Platforms and a car park
represented by a 'Feature Surface', it is easy to offset each 'Platform' and the 'Feature Surface' to adjust for different
material thickness values. However, if the car park had different material thickness values across its surface, we
would run into a problem as there is only one Z offset box for the entire Feature Surface. We could split it up into
different chunks, but this can be awkward. Therefore, in this scenario the 'Reduce Method' can be used to work
around the problem.

3. The Reduce Method

The 'Offset Method' for adjusting FFL levels works well in most circumstances; however, there are scenarios where
you run into difficulties. On some site plans, it can be difficult to break the proposed into different material areas.
Typically, this is the case when the proposed is defined by a single set of elevation features (contours lines or a point
cloud). Breaking the proposed into different elements to cover different material thickness in this scenario can be
awkward and lead to undesirable results at the boundaries of the different elements. As the contour lines or point
cloud were not intended to be broken up, you can end up with large step-downs or jagged edges in the terrain. You
can often fix this by adding more elevation features along the boundary, but another approach is to use the 'Reduce
Method' as opposed to the 'Offset Method'.

The 'Reduce Method' involves putting all the proposed elevations at FFL into a single 'Feature Surface'. You can
actually use a number of absolute elements (Platform, Slope, etc.) but in a simple setup, a single 'Feature Surface' is
used. Once you have finished defining the FFL levels in your absolute element, you then layer 'Reduce' elements over
the top of the Feature Surface to adjust different areas by different material thicknesses.
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'Reduce' elements that intersect will override each other if 'Depths From' is set to ‘Auto’. The lower reduce element in
the list will take precedence in the area of intersection. It is not recommended to change the setting from ‘Auto’ when
using the ‘Reduce Method’ to adjust FFL levels as it is set perfectly to adjust lower FFL elements.

If following the ‘Reduce Method’ there are certain key rules you need to follow:

1. 'Reduce' elements must be in the same phase as the elements that define the finished level.
2. The 'Reduce' elements must be below the finished level elements in the calculation order.
3. Usually the 'Reduce' elements have a very steep side batter (e.g. 0.01 or ‘Off’).
4. The 'Reduce' elements should have ‘Depths From’ set to ‘Auto’.

The ‘Reduce Method’ is, in some ways, simpler than the 'Offset Method'; however, surfaces created using the ‘Offset
Method’ can utilise the powerful side batter creation functionality in Kubla Cubed to create nice joins between
different areas. With the ‘Reduce Method’ you have to create these side batters yourself with break-lines, contours
and points. You can partially overcome this by using a number of absolute elements to define the FFL levels for areas
that can be separated (e.g. building pads, parking lots etc...).

The Adjusting to Subgrade / Formation Level video covers adjusting
FFL levels to the subgrade using the offset and reduce methods.

Soft Landscape (Ponds, Gardens, External Works, etc.)
Soft landscaping areas are usually defined in a site plan with either points or contour lines. Sometimes break-lines
are used if there is a hard edge to the surface, for instance, if there is a slight ridge or gardens have a distinct terraced
design.

The 'Feature Surface' is usually the correct element to use for this as you can define proposed with points, contours,
and break-lines with it. Even though soft landscape areas often do not need adjusting to a subgrade\formation level, it

https://youtu.be/rw2kWY2NZIg
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is a good idea to separate different soft landscape works into different elements. For instance, you might have one for
gardens and another for ponds. This has advantages when it comes to reporting.

Ponds will most frequently be designed with concentric contour lines. However, it is possible to use a platform
element or a number of different platform elements overlaid atop one another to design a pond.

Sometimes as well, you may have a soft landscape area that needs just adjusting by a specified depth or height. For
instance, if you wanted to just spread topsoil over an area you might want to just raise it by a certain height. To do this
kind of operation, you would use the 'Reduce' or 'Raise' elements.

In a bulk earthworks phase, the software landscape areas are usually defined first and are at the top of the calculation
order. This is so hard landscape areas such as building pads, car parks, roads and paths override them. For instance, a
typical calculation order for a housing estate would be:

Note:  The soft landscaped areas Gardens are higher in the calculation order; when they intersect with the hard
landscape areas, defined in lower elements, they are overridden.

The Kubla Cubed Detention Ponds / Basins video explains how to
design ponds with elevations from a fixed datum, depths from a base
level, and calculating volumes using contour lines from a site plan.

Hard Landscape (Building Pads, Drives, Car Parks, etc.)
If you are following the 'Reduce Method' approach of defining the entire site in a 'Feature Surface' and then adjusting
to a subgrade/formation level using the 'Reduce' element, then hard landscaping can be modelled with contour lines
and break-lines. Points are not a good way of defining hard landscaping areas, as they are not necessarily joined in the
way you would expect for hard edges (e.g. the edge of a building pad or car park).

Firstly, closed contour lines can be used to define building pads and other flat areas. Break-lines can be drawn around
the perimeter of car parks etc., to add that detail. However, when modelling hard landscaping, the 'Offset Method'

https://youtu.be/wHwN9uGSsJM
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by which different areas of construction thickness are defined in different 'Feature Surfaces' tends to create accurate
surfaces far more easilty than the 'Reduce Method'. With the 'Reduce Method', a lot of time is often spent on break-
lines, contours, and points to get the same effect of a few elevation elements combined. This is because Kubla Cubed
generates side slopes for all elements. However, when defining the whole site in one feature, all the side slopes of
buildings, car parks, ramps etc. have to be defined with contours, etc.

As with all take-off work, there is no one correct way to define things; however, the following recommendations
provide a good starting point when using the 'Offset Method' regarding which elements to use:

• Building Pads, Drives, Garages: For these, the 'Platform' element can be used. Different areas in the same
Platform element can be defined with different outlines. However, all areas in a single 'Platform' will have the
same elevation. If you have many pads with different elevations (such as in a housing project), a 'Feature Surface'
will allow you to define different pads with the 'Fixed Level Outlines'. A unique 'Fixed Level Outline' for each
pad.

• Car Parks: If the car park is a consistent slope or two consistent slopes, the 'Slope' element can be used.
Frequently, though, a car park is defined on a plan with elevations along the perimeter. In this case, it is often
easiest to use a 'Feature Surface' and a 'Varying Level Outline'. Break-lines or points can be used, to add extra
elevations inside the car park for added details.

• Ramps: The 'Slope' element is useful for creating ramps. If the ramps are all on the same plane, multiple outlines
within the same 'Slope' element can define them. However, if they are not, then multiple slope elements can be
used.

When using the 'Offset Method' and splitting areas into different 'Feature Surfaces', some consideration needs to be
made regarding the order of the elements. The elements lower in the calculation order will override the ones above.
It is a good idea to put the more expansive areas at the top and the more detailed areas lower down. You don't need to
carefully snap the boundaries between different areas together if you use the overriding behaviour strategically.

Recreational Grounds (Golf Course, Sports Pitch, etc.)
Sports pitches often are very simple geometrically. For instance, a football pitch or tennis court could be simply
defined with a 'Platform'. However, these types of pitches, although appearing to be flat, often are on a slight slope for
drainage reasons. Therefor the slope element might be more appropriate.

A baseball pitch requires a bit more consideration. In this case, there is usually a falloff in elevation from the pitcher's
mound. This can be achieved by creating a feature surface and using concentric contour lines to define the desired
topography.

Golf Courses tend to feature smooth, undulating terrain. However, hard edges exist at the perimeter of bunkers and
ponds. On a plan, a golf course design is likely to be specified with contours, points and break-lines. The break-lines
would be used for the defined edges, such as the bunker or water feature perimeter. Naturally, for these scenarios you
would use a 'Feature Surface' in the proposed phase to design a golf course. It is also possible to prototype different
golf course designs by combining different elements together. For instance, using Platforms to sketch out ideas can
be far quicker and simpler than designing with contour lines. When happy with the design and estimated volumes,
exporting contour lines to CAD could be useful for additional refinement and to create a smoother surface than that
which was created with overlaid Platforms.

Roads and Paths
There are several ways to define roads and paths in Kubla Cubed. Starting with a simple footpath, the obvious choice
is to use the 'Path' element. This allows you to place points along the centre line of a path and set absolute elevations.
If you leave a point's Z entry blank it will interpolate from its neighbours. After creating the centre lines, you can set a
width of the Path. Another choice for a simple path is to create a 'Berm'; this will follow the topography of the centre-
line at the specified relative heights specified.
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If you are defining roads, you can, of course, use the 'Path' and 'Berm' elements in the same way. However, it is
usually better to use the ‘Feature Surface’ for roads that handle traffic. With the 'Feature Surface' you define the
perimeter of the road with a 'Feature Surface' outline. You can also use an outline within an outline to define a road
that completely encloses a space.

There are a few different approaches to take in regard to defining the feature surface depending on the data that is
marked on the site plan:

• Extrapolate Outlines and Contour Lines (Not Recommended) : This works OK, but hundreds, if not
thousands, of contour lines are often required to represent a road surface smoothly. The other methods are more
efficient. This method is only used if contours are already defined in CAD or are the only thing marked on the site
plan.

• Extrapolate Outline and Break Lines (Quick) :Another approach for defining roads with a 'Feature Surface',
which is quite quick, is to define the centre line with a break line and then the road perimeter with an 'Extrapolate
Outline'. This creates a flat road surface, which isn’t optimal as most roads have a camber.

• Varying Levels Outlines and Break Lines (Recommended) : The recommended approach for defining a road
surface is, within a 'Feature Surface', define a centre line with a break line and then use a 'Varying Level Outline'
to input the levels of the road perimeter. This allows you to define the camber of the road, which is often desirable
to get the most accurate surface. If there is no centre line marked on a site plan, using a 'Varying Level Outline'
without the centre line is the best option.
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We've discussed the road surface, but often you will also want to complete footpaths down the sides of roads for
pedestrian or bicycle traffic. This can be achieved by creating separate 'Feature Surfaces' below the main road surface
in the calculation order for the pavements. If using the ‘Offset Method’ of subgrade adjustment, you can then offset
the road surface and footpaths separately. To avoid having to snap the side of the pavements to the sides of the
roads exactly, it is best to define the footpaths in the same phase as the road surface. If the footpaths are lower in the
calculation order then you can tuck the roads underneath the footpaths. In the areas of intersection, the footpaths will
override the road elevations, creating a smooth join between the two.

The Roads and Paths video demonstrates three methods for defining
roads and paths, in Kubla Cubed.

Retaining Walls
There are broadly two different approaches to defining retaining walls: The first is using break-lines within a 'Feature
Surface', and the second involves combining different elements together like the 'Platform' and 'Path' together. If
adjusting to subgrade using the 'Reduce Method' (i.e a 'Feature Surface' with a number of 'Reduce' elements) then
break-lines within the 'Feature Surface' would be used. However, when employing the 'Offset Method' you could still
use break-lines within a 'Feature Surface', and there is also an option of building up the retaining wall with various
elevation elements.

Break-Lines

With the break-line method, you would first input the elevations on both sides of the wall. These would likely be
points but could also be with contours that stop just shy of the wall. Then, you would input two break-lines: one at
the top of the wall and one at the bottom. The gap between the break-lines would indicate the width of the wall slope
when viewed on a plan. For instance, a near vertical wall would have break-lines very close, whereas as are gentle
slope would be much wider.

https://www.youtube.com/watch?v=TEwS3BSEXYI
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Combining Elements

Another approach with retaining walls is to define them by combining different elements. For instance, the wall itself
can be represented by a 'Path' (using absolute elevations) or a 'Berm' (using relative elevations). The backfill can then
be defined with a 'Platform' element if the area is flat or a 'Slope' or 'Feature Surface' if not. With a backfill element,
such as a 'Platform' it might be advantageous to set the mode to ‘Fill' only so the element only fills to the ground and
wall level rather than cutting from it.

Side Batter to Define Retaining Walls



Using Kubla Cubed elements such as the Feature Surface, Platform, or Triangle Surface, you can define the element
and then edit the side batter to generate a wall. For example, the image below shows a terraced landscape using the
three elements mentioned previously. Watch our video on retaining walls to see how this is done.

The Kubla Cubed | Defining Retaining Walls video explores methods for
creating dramatic topographical changes with Kubla Cubed's tools.

https://youtu.be/0A9spj5Dats
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Utility Trenches

Topics:

• Trenches, Ditches

Trenches, channels, and ditches are excavated for utilities such as gas,
water, sewage pipes and telecom cables. Kubla Cubed offers excellent tools,
including Trench, Path and Berm, which can be utilised to define the trench
and complete multiple backfill phases.
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Trenches, Ditches
In Kubla Cubed, two key elevation elements are useful for defining trenches.

1. Trench Element:

When using the Trench element, set the depth by using a positive value. The Trench element is a relative element, so
the values are specified as 'depths'.

Style of Trench:

With some small changes, you can adjust the appearance of a trench. After defining a centreline and setting the
depths, adjust the Width of the trench and Side Batter to generate different styles of trench. Three examples are shown
below:
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The below image displays the cross sections of the three trench elements (above) giving another perspective of the
differing Widths and Side Batters.

Note:  In cases where two trenches intersect, the depth value from the trench with the greatest depth at the point of
intersection will be used.

2. Path Element:

To define trenches using absolute elevations, use the Path element.

1. Draw the centreline (points on the line without a value will be interpolated).
2. Set width and side batters. To create a V trench, set width to 0.
3. If two paths intersect, the one with the higher depth will take precedence.

When using the Path element, if you leave an elevation blank, it will interpolate from the neighbors. For a constant
elevation, set the same value at the beginning and end, leaving the others blank or marked as 'not set.'
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Foundations, Footings

Topics:

• Modelling Foundations
• Backfilling
• Filling Around Structural

Elements

Kubla Cubed is a general earthworks estimation software, allowing users
to calculate foundation volumes, even though they are usually fairly
straightforward to measure by simple hand calculations. However, there are
advantages to modelling foundations in Kubla Cubed, particularly where
backfilling around the foundations is required. Additionally, it is useful for
creating step-by-step 3D images of the work taking place.
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Modelling Foundations
The volume of foundations can be modeled in Kubla Cubed in just the same way as any other earthworks element.
The only real differences are that the side batter for foundations is almost always set to vertical, and foundations often
have holes inside them. The ability to cut holes out of volumes is a standard feature in Kubla Cubed, but is much less
commonly used for actual earthworks elements. Cutting holes is easily achieved by adding internal outlines within the
external ones. The internal outlines will be automatically detected and removed as holes.

The ability to remove internal areas is an occasionally used feature for normal earthworks elements but is routinely required when modeling foundations.

With the Building Foundations video, discover how to quickly and
effectively combine Reduce and Platform earthwork elements in the
creation of models.

Backfilling
Backfilling is the process of filling up a cavity with material after an excavation. Kubla Cubed can be used to
calculate the material that will be used in a backfilling operation. It is critical to note that an additional phase is
required to complete a backfill operation; excavation and backfill cannot be completed in a single phase.

Several elements can be used to define the surface of the backfill material. However, there is a trick that can save time
when tracing around the perimeter of a cavity. If we set an element like the 'Platform' to ‘Fill' only mode it cannot cut
from the surface. Using this technique, we can trace a 'Platform' over the general area of backfill, and it will fill up the
cavities to the given level. As long as the elevations around the cavities are higher than the backfill level, than they
will remain untouched.

https://youtu.be/rR9yMYv3vWQ
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Excavation in one phase has been backfilled in a subsequent phase by using a platform over the area and setting the platform to ‘Fill' only mode.

It's worth nothing that the backfill trick does not require the backfill to be at a set fixed level to work; you can use the
same technique with any other absolute element (e.g. Slope or Feature Surface).

Filling Around Structural Elements
Another trick that can be employed when estimating building foundation volumes is to create phase that contains
structural elements, which will be ignored from the cut and fill calculations. The fill for these elements will be
calculated, but it is often irrelevant, as the elements could be precast concrete or a temporary concrete framework. In a
way, they could be described as 'dummy earthworks' elements used to create a solid surface where structural elements
will be.

In a subsequent phase, elements can be set to ‘Fill' only and fill can be added around those structural elements. This
can make the job of filling around complex space a lot easier, and the visualisations make more sense. An alternative
approach is to define the boundary outlines of the proposed structure carefully to leave the structural areas untouched.
However, the models created by using ‘dummy earthworks’ for structural elements tend to be easier to understand.

Dummy earthworks used to represent precast concrete pillars and wooden frame before estimating concrete fill volumes in a subsequent phase.
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Paving, Turf and Sod

Topics:

• Using Reported Areas to
Calculate Paving Volumes

• Using the Raise Element to
Report Paving Volumes

• Obtaining a Breakdown of
different Paving Strata

Paving refers to a layer of hard material that constitutes the surface of a built
environment, such as a road, pavement, or driveway. In this chapter, we use
the term more broadly to discuss the layers completed in the final phases of a
project, building up to finished level. This can include materials such as turf
(sod), asphalt, tiles, woodchip, or any other material. The bulk earthworks,
as discussed in earlier chapters, will result in topography defined to the
Formation/Subgrade Level with cavities where paving will be laid.

Estimating paving is commonly done by measuring the area and then
calculating the the volume using a simple formula: Area x Paving Thickness.
While this method is often sufficient, it is also possible to model the paving
build up in Kubla Cubed by modeling the paving elevations and calculating
the volumes.
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Using Reported Areas to Calculate Paving Volumes
Estimators commonly use Kubla Cubed for volume measurements and use another 2D take-off program to area
measurements calculating the paving volumes by multiplying the area by the thickness. While this a straightforward
approach, it may involve measuring the same areas twice—once in Kubla Cubed and once in the other program. This
can be timeconsuming, requiring the importation of site plans twice and scaling and stitching twice.

Kubla Cubed  offers a more streamlined alternative. The first method involves using the ‘Area’ element found in the
‘Measurements’ panel. With this, you can take-off area measurements and use the 2D Boundary Area in the ‘User
Input’ reports for paving estimates. While effective, it does not use 3D areas and may require you to retrace areas
previously traced during the bulk earthworks phases. Neverthelesss, it does eliminate the need to import site plans
into another program

Choosing between 2D or 3D Areas

Before using areas to calculate paving volumes, it is worth considering whether to use 2D or 3D areas. The 2D areas
reported are the same as if measured from a paper plan, often the traditional approach to estimating paving volumes.
The 3D areas take into account the surface area of the topography and will always be the same or larger than the 2D
area. While 2D areas are generally sufficient for calculating paving, 3D areas might be necessary on steep inclines
where the surface area in 3D is far greater than when viewed from above. For instance, when calculating the turf
needed for a golf course, relying solely on a 2D area might leave you considerably short of the true requirement.

Another method to obtain the areas is to use the disturbance areas from the earthworks estimation. You can choose
between he 2D areas or 3D areas based on your requirements. If you have set up your bulk earthworks in either of the
following ways :

• A. Using the ‘Offset Method’, where different paving areas are represented by different elements.

or

• B. Using the ‘Reduce Method’, where different paving areas are being reduced by different 'Reduce' elements.

Then the ‘Volumes by Element’ in the 'Estimation Data Spreadsheet' can be used to find the areas of the paving. Both
2D and 3D areas are available depending on your requirements.
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There is one catch with this method: if an element does not actually change the ground in a specific area, for
instance, if an earthworks element only ends up changing 70% of the ground (i.e., some of the proposed levels
match the ground level), the disturbance areas will not report the whole area. Therefore, it cannot be used for paving
calculations. Another issue may arise when disturbance areas include the side batter of an element, which may not be
what’s required. In this case, another method would have to be used.

Why not use Boundary 2D Areas contained in the User Input Reports?

It is possible to use Boundary 2D Areas reported in the 'User Input 'reports for this task, but there are a couple of
issues. Firstly, they report the area of the boundary outline, which does not include the side slopes of the earthworks
(although this might be desirable). A potentially more significant problem relates to intersecting earthworks
elements. If two earthwork elements intersect, the one lower in the calculation order will report in the area of
intersection. Tthis means you will not get double reporting of disturbance areas (2D or 3D) or volumes. However,
the 'User Input' areas do not have this benefit so the areas will double report paving if two earthwork elements
intersect.

Using the Raise Element to Report Paving Volumes
Rather than taking areas and then multiplying then by paving thickness to calculate the volume of paving, modeling
the paving using earthworks elements can be beneficial. Although this method might be a bit slower than using
areas reported in previous phases, it does have the advantage of resulting in the last phase of your project built up to
finished level. This is useful for checking your site, as you can perform spot checks or cross sections to verify the
elevations reported from the model against the site plan (site plans almost always show FFL levels).

To complete paving calculations using Kubla Cubed’s modelling tools, a process similar to completing a topsoil strip
in reverse is applied:

1. Define paving in its own phase by creating a new phase named 'Paving' or a similar designation.



2. Use 'Raise' elements with a height set to the overall thickness of paving. If 'Raise' elements overlap, they
will override each other. In cases of intersection, the depth in the lower element in the calculation order takes
precedence.

3. Ensure that the 'Raise' element has the 'Heights From' property set to 'Ground' (the default) if there are no absolute
elements above in the calculation order. It is not recommended to change these options from the default settings or
use absolute elements in a paving phase to maintain consistent behavior of 'Raise' elements overriding each other.

Paving volumes calculated using 'Raise' elements, with the lower element in the calculation order taking precedence at intersections (using default settings).

Obtaining a Breakdown of different Paving Strata
Rarely is paving made up of a single material. For instance, a tiled area will may have layers of sand and gravel
underneath for stability. A road would have even more layers. If you have an overall paving volume calculated, it
is quite easy to break this down into different layers using ratios or percentages. For example, if paving is made
up of 20% tile, 20% sand and 60% gravel, breaking down the overall paving volume into different materials in a
spreadsheet is straightforward.

However, you can also model this also in Kubla Cubed. To do so, create different phases for each layer and use
'Reduce' elements with a height set to just the thickness of the strata. This method has the benefit of each material in
paving having a separate volume in the exported reports and spreadsheets. It is best to have one phase per material
and name the phase after the material. For many projects, this might be considered overkill given how easy it is to
complete in a spreadsheet, but it is possible to do this if needed.



Chapter

16
Marine Dredging & Reclamation

Topics:

• Coordinates and Bathymetry
• Modelling tools
• Visualisation

Kubla Cubed is routinely used to calculate dredging and reclamation
quantities for coastal engineering projects. Kubla Cubed not only excels
at this but also makes it extremely quick and easy to explore dredging and
reclamation options at the concept design stage.

It should be noted that Kubla Cubed is not specialist coastal engineering
software and Kubla offers a more specialised software called Kubla Ports. If
you are heavily involved in coastal engineering, you may wish to investigate
this software as well.

In this chapter, we'll discuss the coordinate system used in Kubla Cubed and
the potential requirement to convert data before editing. There is coverage of
bathymetry (measurement of depths below landform) before a focus on how
different Cubed elements and settings can effectively contribute to a coastal
project.

https://www.kublasoftware.com/kubla-ports/
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Coordinates and Bathymetry
Coordinates

Kubla Cubed uses a Cartesian coordinate system, either in metres (mE, mN) or feet (ftE, ftN). The coordinate system
is not defined in the software, and it’s up to the user to ensure that all the data they are loading is in a consistent
Cartesian coordinate system.

In coastal engineering, it is common to have data in a spherical coordinate system (°E, °N). If you have such data, you
will need to use other software to convert it into a Cartesian coordinate system of your choice, such as UTM, before
importing into Kubla Cubed. If you have raster images in spherical coordinates that you want to load as site plans,
you should ideally use software to skew them into your chosen Cartesian coordinate system before loading them as
site plans.

Processing Bathymetry

One of the biggest challenges with coastal engineering projects is dealing with a wide range of bathymetric data
sources, from PDF contour maps to raw data from echo sounders in text files. Kubla Cubed can combine data from
various sources, but like any ground modelling software, careful consideration needs to be given to how you define
your bathymetry.

As Kubla Cubed is based on Triangulated Irregular Networks (TINs), it’s possible to combine a range of disparate
sources of bathymetry data. For example, one part of the site may have high-resolution gridded data from a
bathymetric survey, while another part may only have data from contour lines traced off a PDF.

Bathymetric data as received from echo-sounding likely needs processing before being usable in Kubla Cubed.
Processing is required to remove outliers and erroneous soundings, and also to thin the data to prevent the software
from becoming slow and unusable. Bathymetric processing is a specialist task and beyond the scope of Kubla Cubed,
so it must be done in other software before importing. Typically, the data might be gridded before being imported into
Kubla Cubed. The grid resolution should be adequate for accuracy without being so dense that the software becomes
difficult to use.

Modelling tools
While land-based earthworks projects typically have contoured design levels, coastal projects tend to be somewhat
simpler, involving a series of flat areas to be dredged or reclaimed. For this reason, some design elements available in
Kubla Cubed are rarely used on coastal projects. The following two elements are typically the most useful:

• Platforms: Used to define flat areas by drawing the outline of the flat area. These are useful for dredging berth
pockets and turning circles, for example.

• Paths:  Used to define areas by drawing a centreline and specifying the width. These are useful for dredging
channels, for example.

Cut Only and Fill Only

One of the key differences between typical coastal engineering projects and land-based earthworks is that only cut
or only fill is often specified. For example, in a dredging project, you only remove material and do not fill to the
designed level. Since Kubla Cubed has been used for coastal engineering from the outset, this has always been an
option on every earthworks element. Achieving this is simply a matter of setting the ‘Mode’ to ‘Cut’ instead of the
default ‘Cut & Fill’.
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Mode: Cut & Fill Mode: Cut

The cut-only mode, which is rarely used on land-based projects, is routinely required for coastal projects.

Side Batters

One powerful feature of Kubla Cubed is the ability to automatically generate side batters to slope between the design
ground levels and the existing bathymetry. This is particularly important for coastal projects, where the batter angles
can be quite low, and the volumes within these batters can represent a significant part of the total volumes. See Side
Batters on page 54.

Side Batters: Off Side Batters: External

Side batters can comprise a significant part of the volumes on coastal projects. Kubla Cubed generates them automatically and you can adjust the batter

angles as required.

Visualisation
Kubla Cubed offers a range of editable effects to aid visualisation.

Vertical Exaggeration

Due to the scale of coastal engineering projects, the variation in Z values is usually trivial compared to the size of the
project. As a result, 3D visuals can appear to be almost flat. For this reason, Kubla Cubed allows you to exaggerate
the vertical scale when you are viewing in 3D. See Vertical Exaggeration on page 29.

No vertical exaggeration Vertical exaggeration applied



The vertical exaggeration can be increased to improve understanding of the variations in 3D topology when viewing very large projects.

Shading Schemes

Since typical dredging projects are cut-only, as described above, the default shading scheme—which displays cut
in varying shades of red, and fill in varying shades of blue—is not particularly appropriate. Commonly, dredging
is displayed in a Rainbow shading scheme, which maximises the contrast in dredging depths. This is provided as a
default shading scheme, but you can also customise as required.

Default red (cut) and blue (fill) shading Preset shading scheme 'Rainbow' applied

Typically the rainbow shading scheme is used to display dredging depths, rather than the default red and blue.



Chapter

17
Stockpile Volumes

Topics:

• Importing Survey Point File
(.CSV, .XYZ, .XLS, .UAV)

• Calculate the Volume of the
Stockpile - Platform

• Calculate the Volume of the
Stockpile - Feature Surface

There are various ways to calculate the volume of stockpiles, in Kubla Cubed.
This chapter will demonstrate how to import survey data from your stockpile
and then guide you on how to calculate the volume.
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Importing Survey Point File (.CSV, .XYZ, .XLS, .UAV)
With the first phase (called 'existing') selected, add a new element of the type 'Feature Surface' from the earthworks
panel in the top right. This element will act as container for the data to be imported. Your survey files will contain
points stored in text based format, typically .csv, .xyz, xls, or .uav (e.g. mydata.csv).

• ① Open the 'Feature Surface' for your new project.
• ② On the left-hand side, you will see a panel with four headings (Outlines, Contours, Breaks, and Points). Since

you will be editing points, make sure to select the fourth tab, 'Points'.
• ③ In the bottom left corner, locate the second button, 'Add Points from Site Plan or File.' Hover your mouse

above the button to view a tool-tip, ensuring you are selecting the correct option, then left-click.
• ④ Choose the file you want to import when prompted.
• ⑤ A new window will appear, allowing you to modify the file format settings. Confirm that the X, Y, Z columns

in your file are correctly displayed in the table. Once satisfied, click the OK button to load the points into your
project.

• To complete the process, add the boundary outline of the stockpile. Select the first tab at the top of the panel,
marked 'Outlines.' Click on one of the buttons at the bottom to either create or load an outline. For creating an
outline, choose between 'Automatic' and 'Draw.' Automatic will shrink-wrap the points, with the process being
software-controlled. A preview with a fidelity slider is provided before completion. Drawing the outline manually
is human-controlled. Alternatively, if you have a PDF or CAD file with the outline defined, import it by adding
from the file, as mentioned previously.

Additionally, if your stockpile has been defined in a CAD or PDF format, then there is also the option to add points,
contours and break lines from these files by selecting a sample entity of the points/lines you want to import. Go to the
CAD import section for more details.

Calculate the Volume of the Stockpile - Platform
With the existing surface now complete, you can move to the 'Proposed 1' tab to create a 'Platform' and calculate the
volume. This is the recommended method when using the Lite version of the software, where the Feature Surface
element is not available. For the preferred method in Kubla Cubed Professional, see the Feature Surface section.
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• ① Add a 'Platform' by clicking on the '+' button in the Elevations menu.
• ② Use your cursor to draw a boundary around the stockpile base, and click 'OK'.
• ③ In the 'Elevations' panel, adjust the level of 'Platform' to match the average elevation level at the stockpile base.
• ④ Change the 'Mode' to 'Cut' only.
• ⑤ Using the 'Display' panel options, observe the 2D and 3D visualisations of the stockpile cut.
• ⑥ 'Cut' volume total is displayed.

In this scenario, the survey data of the stockpile serves as the 'Existing' surface, while a flat area is designated as the
'Proposed' surface. We are instructing the program to calculate the 'cut' volume, representing the excavation needed
to achieve a specified level and perimeter for the stockpile. After defining the stockpile elevations in the 'Existing'
phase, they are adjusted to the Platform level. As a result, the cut volume, indicating the volume of material to be
excavated from the stockpile, can be found in the top left-hand corner of the interface and in the export reports, and
spreadsheets.

See how to calculate stockpile volumes in this video: How to Calculate
Stockpiles with Free Software.

https://youtu.be/Ocs4I_BIFHM?si=rQBnZ_LE71TD60oB
https://youtu.be/Ocs4I_BIFHM?si=rQBnZ_LE71TD60oB
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Calculate the Volume of the Stockpile - Feature Surface
With the existing surface complete, proceed to the 'Proposed 1' tab to create a 'Feature Surface' to calculate the
volume of your stockpile by following the steps below:

1. Add a 'Feature Surface' by clicking on the '+' button in the Elevations menu.
2. Add a new manual Outline (pencil button) → select 'Draw' → 'Define Varying Levels
3. Use your cursor ① to draw a boundary around the stockpile base, read the Ground Z elevation shown on the

cursor label ② and type into the box ③, then click 'Continue' ④ or the 'Enter' key to add a new point to the
boundary.

4.

5. Once the boundary has been defined, click 'Complete' ⑤ → 'Finish' → 'OK'.
6. In the 'Elevations' panel, change the 'Mode' to 'Cut' only.
7. Adjust the side batter, as needed.
8. Using the 'Display' panel options, observe the 2D and 3D visualisations of the stockpile cut.
9. The 'Cut' volume total is displayed on the left-hand side and in the estimation spreadsheet/report exports.
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In this scenario, the survey data of the stockpile serves as the 'Existing' surface, while a flat area is designated
as the 'Proposed' surface. After defining the stockpile elevations in the 'Existing' phase, they are adjusted to the
Feature Surface Varying Levels Outline. The cut volume, indicating the volume of material to be excavated from the
stockpile, can be found in the top left-hand corner of the interface, as well as in the export reports and spreadsheets.
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Exporting Spreadsheets & Reports

Topics:

• Creating Reports
• Creating Spreadsheets

When it comes to presenting the results of a project to a client, colleague or
other stake-holder, Kubla Cubed has a number of options available:

• Spreadsheets:  An earthworks estimation spreadsheet can be produced
that breaks down the earthworks in each phase. There are subsequent
breakdowns by region, and by element. Another spreadsheet containing
input data can also be produced, which is useful for validating inputs and
viewing measurement information. For more information see Creating
Spreadsheets.

• Reports:  An earthworks estimation report can also be produced with the
same breakdown as the spreadsheet. The report contains diagrams and
formatting that makes it easier to understand so is often more appropriate
to give to clients than the spreadsheet. A report containing input data
can also be produced for validating inputs and viewing measurement
information. For more information see Creating Reports.

• Reporting in the Software: For all phases except the first, a statistics
panel will display in the top left with cut and fill data. The level of detail
can be controlled from the 'Project Settings', located in the 'Settings' menu.
The statistics panel will not show when an element is being edited.

Within the program the options for presenting the above data are contained
within the File menu. Here you will find the Create Spreadsheet and Create
Report sub menus.
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Creating Reports
To export a report click on the File menu item, then Create Report and finally Input Data or Estimation, depending on
the report you wish to create. The report can be saved in the MS Word (.docx) or Adobe Acrobat (.pdf) format.

Input Data Report

A report of the user input data, including all properties, boundary areas and perimeters. The report can be useful for
validating input data and using boundary perimeter and area values in a bill of quantities (BOQ) or for doing further
calculations on the data.

The report will contain the input data that has been entered by the user into the program. It contains no information
regarding earthworks calculations (cut & fill); that information is contained in the earthworks estimation report.
The count, area and length measurement elements will only appear in this report as they have no relevance to the
earthworks estimate.

Notes on Boundary 2D Area and 2D Perimeter : The boundary areas and boundary perimeters in the input data
report relate to the element boundary lines that have been input by the user. They will often differ considerably from
the areas in the earthworks estimation report which are calculated from the earthworks area of disturbance.

Volume region elements are not allowed to overlap each other. Where one volume region is inside another, the area
of the internal volume region will be removed from the external one. The area and perimeters presented for volume
regions in the report are the areas after they have undergone this processing.

Estimation Report

A report of the earthworks estimations, including levels, volumes and depths can be exported to a .xlsx file. The
report can be useful for building into an earthworks bill of quantities (BOQ) report or for doing further calculations on
the data.

This report will contain the earthworks estimation output calculated by the program. This includes cut\fill volumes,
depths and areas. The earthworks estimate is completed for all earthworks in the phase. In addition it can contain the
following breakdowns.

• Breakdown by Element: The element breakdown will show you the cut & fill contribution of each element in a
phase, based on the disturbance areas of each element. This can be very useful if different earthworks have been
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represented by different elements (e.g. roads, building pads, gardens etc...). If elements intersect then consider
how to attribute the cut & fill in the intersecting areas. The approach used in Kubla Cubed is to report the cut &
fill to the element that appears lowest in the calculation order. This correlates to the way that element elevations
override each other in most scenarios, the lower element takes priority.

It is important to note that the element breakdown does not calculate cut & fill between elements. In Kubla Cubed
within each phase, all earthworks elements are combined into a single surface and cut & fill is calculated between
the resulting proposed surface and the ground surface. However, multiple phases can be used if you want to
calculate cut and fill between multiple surfaces. The earthworks report is helpful for viewing the breakdown by
element regions, as it has a diagram above each element breakdown table.

• Breakdown by Region: If volume region elements exist in a phase, a breakdown by region will be completed.
A region within a region will be handled by first calculating the outer region excluding the inner region and then
calculating the inner region separately.

Notes on Earthworks Estimation 2D and 3D Areas : 2D and 3D areas in the earthwork estimation report relate to
the earthworks footprint (sometimes referred to as the area of disturbance). For the area and perimeter of the element
boundaries refer to the input data report. The 2D areas reported are the same as if measured from a paper plan. The
3D areas take into account the surface area of the topography and therefore will always be the same or larger than the
2D areas.

Exports - Report & Spreadsheets video describes the main sections of a
typical report.

Creating Spreadsheets
To export a spreadsheet click on the File menu item, then Create Spreadsheet, and finally Input Data or Estimation,
depending on the spreadsheet you wish to create. The spreadsheet can be saved in the MS Excel (.xlsx ) format.

Input Data Spreadsheet

https://youtu.be/0oXTe-cUlhc
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A spreadsheet of the user input data, including all properties, boundary areas and perimeters. The spreadsheet can
be useful for validating input data and using boundary perimeter and area values in a bill of quantities (BOQ) or for
doing further calculations on the data.

The spreadsheet will contain the input data that has been entered by the user into the program. It contains no
information regarding earthworks calculations (cut & fill); that information is contained in the earthworks estimation
data spreadsheet. The count, area and length measurement elements will only appear in this report as they have no
relevance to the earthworks estimate.

Notes on Boundary 2D Area and 2D Perimeter : The boundary areas and boundary perimeters in the input data
spreadsheet relate to the element boundary lines that have been input by the user. They will often differ considerably
from the areas in the earthworks estimation report which are calculated from the earthworks area of disturbance.

Volume region elements are not allowed to overlap each other. Where one volume region is inside another, the area
of the internal volume region will be removed from the external one. The area and perimeters presented for volume
regions in the spreadsheet are the areas after they have undergone this processing.

Estimation Data Spreadsheet

A spreadsheet of the earthworks estimations, including levels, volumes and depths can be exported to a .xlsx file.
The spreadsheet can be useful for building into an earthworks bill of quantities (BOQ) report or for doing further
calculations on the data.

This spreadsheet contains the earthworks estimation output calculated by the program. This includes cut\fill volumes,
depths and areas.
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The earthworks estimate is completed for all earthworks in each phase, in addition it can contain the following
breakdowns.

• Breakdown by Element: The element breakdown will show you the cut & fill contribution of each element in a
phase, based on the disturbance areas of each element. This can be very useful if different earthworks have been
represented by different elements (e.g. roads, building pads, gardens etc...). If elements intersect then consider
how to attribute the cut & fill in the intersecting areas. The approach used in Kubla Cubed is to report the cut &
fill to the element that appears lowest in the calculation order. This correlates to the way that element elevations
override each other in most scenarios, the lower element takes priority.

It is important to note that the element breakdown does not calculate cut & fill between elements. In Kubla Cubed
within each phase, all earthworks elements are combined into a single surface and cut & fill is calculated between
the resulting proposed surface and the ground surface. However, multiple phases can be used if you want to
calculate cut and fill between multiple surfaces. The earthworks report is helpful for viewing the breakdown by
element regions, as it has a diagram above each element breakdown table.

• Breakdown by Region: If volume region elements exist in a phase, a breakdown by region will be completed.
A region within a region will be handled by first calculating the outer region excluding the inner region and then
calculating the inner region separately.

Notes on Earthworks Estimation 2D and 3D Areas : 2D and 3D areas in the earthwork estimation data spreadsheet
relate to the earthworks footprint (sometimes referred to as the area of disturbance). For the area and perimeter of
the element boundaries refer to the input data spreadsheet. The 2D areas reported are the same as if measured from a
paper plan. The 3D areas take into account the surface area of the topography and therefore will always be the same
or larger than the 2D areas.

Cross Sections Spreadsheet

A separate tab/sheet will appear for each phase. Each sheet shows sections top to bottom.

There are five column headings: Section Name; Segment Number (meaningful for long sections); Distance (each value
is relative to the start position); Ground Level and Proposed Level.



Blank rows separate proposed elevations from existing, which are in row separated groups to make chart creation
easier. When creating a graph in your favourite spreadsheet editor, select data and headings from the last three
columns. Insert a chart and ensure it is a Scatter graph. We suggest 'XY Scatter' & 'Lines Only' in LibreOffice Calc;
'Scatter' & 'Scatter with Straight Lines' in MS Office Excel.

Exports - Report & Spreadsheets video describes the main sections of a
typical spreadsheet.

https://youtu.be/0oXTe-cUlhc
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Exporting Images & Drawings

Topics:

• Creating Drawings
• Export Image
• Export to LandXML

When it comes to presenting the results of a project to a client, colleague or
other stake-holder, Kubla Cubed has a number of options available:

• Drawings:  Summary drawings can be presented of the project, showing
a plan view of each phase, as well as the summary volumes and any
transects that have been defined. These drawings can be exported either
to a PDF file or to various CAD file formats. For more information see
Creating Drawings.

• LandXML Data: A lot of the project data can be exported to this
specialist land surveying file format. LandXML is a popular data transfer
format used to import\export line-work, survey points and surfaces. Like
the CAD data, LandXML can also be used to import data into machine
control systems. For more information see Exporting LandXml Data.

• Images:  Images showing the design area can be exported to a several file
formats. The images can display the shaded terrain and earthworks, and
can optionally include grid lines, colour keys and contour lines. For more
information see Creating Images.

Within the program the options for presenting the above data are contained
within the File menu. Here you will find the Create Spreadsheet, Create
Report and Create Drawing sub menus. For CAD Data and LandXML Data
use the Export menu.
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Creating Drawings
The project data in Kubla Cubed can be presented as drawings, which can be saved either as PDF or to various CAD
file formats. These drawings will include plan views of each phase you export, along with colour keys, earthworks
quantity summary tables and transects if you have defined any.

To create a drawing, click on File, Create Drawing, and then PDF or CAD.

The available options on this form are described below:

• ① Choose from several standard paper sizes from A0 to A4
• ② The Phases drop-down allows you to select which phases to include in the drawings. By default, only the

selected phase and the existing phase are included. File layers are used to separate the entities by phase.
• ③ Include all visible site plans.
• The 'Merge Layers' option (CAD only)

• Selected (recommended for simplicity) - All visible site plan drawing content is grouped into a single layer.
Hidden, or turned off layers are removed. Visual appearance is preserved by applying layer properties directly
to each entity before merging

• Off (full layer separation and control) - Site Plan entities remain on their original layers, as they are in the
source drawing; Hidden layers retained (may still be visible in CAD depending on settings); All layers
associated with the site plan are prefixed with the site plan name for ease of reference.

• ④ Input Data: Select whether the drawings should include the user-input data (contours, points, boundaries etc.).
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• ⑤ Triangulations: Select whether to include the TINS in the drawings. Often, the TINS are not required if you are
just interested in a contour line or gridded data visualisation.

• Disturbance Area Only In some scenarios when exporting proposed surfaces, you may not want the
undisturbed ground in the drawings.

• Shade Surfaces - The option cuts the mesh into different areas/clusters for different colours. Note: This results
in multiple meshes, which may not be suitable for import to other software. Unchecking this option will retain
the original mesh integrity.

• ⑥ Contour Lines: Choose to generate surface contour lines. Note that contour lines used to define 'Feature
Surfaces' in Kubla Cubed will be included if 'Input Data' is checked. These are not the contour lines referred to in
this section. The contour lines in this section are an entirely new set that are generated from the entire proposed
surface.

• Label Contours: You can choose to turn off the labeling of contour lines.
• Starting At: In this box, set the level the contour lines start. It is advised to start on a round number. The

default will be set to the bottom of the surface rounded down.
• Contour Interval: In this box, set the interval distance between each contour line. Very small contour intervals

can cause large export times and large file sizes.
• ⑦ As well as generating contour lines from the TINS, you can also include gridded data. This feature can be

used to create a cut\fill plan for site engineers or present results to those accustomed to using the grid method for
calculations.

• Label Points: Choose to turn off the labelling of points as it saves space in the file. It is recommended you keep
this on, as the points will have litle meaning otherwise.

• Origin Point: Set the location of the origin point. The grid will extend out from here in all directions until
it exceeds the extents of the surface. It is recommended to use rounded numbers. By default, it is set to the
bottom left, rounded to a whole number.

• Grid Interval: In this box you can set the distance between each grid point. Very small grid intervals can cause
large drawing generation times and large file sizes.

• ⑧ Earthworks linework created by Kubla Cubed can also be included in the drawings.

• Outlines: The outlines of the earthworks can be included, which can be useful for knowing the location of
designed features such as building pads, roads, ponds etc.

• Incline Lines: Kubla Cubed generates 'incline lines' to mark the generated side slopes joining earthworks
elements to the ground. You can choose to include these in the drawings.

• Cut\Fill Lines: The lines can be exported in red and blue, showing the earthworks cut\fill boundaries.
• ⑨ Use the preview to get an indication of the drawing file's content. It is especially useful for previewing the

density of the generated gridded data and generated contour lines. Note that this is only a preview, and your
drawings will not appear exactly as presented here. When multiple phases are selected, you can cycle through
them for preview using controls at the bottom of the preview panel. Multiple phases are not previewed all together
to avoid confusion.

Once the drawing settings have been finalised, click OK. You will be prompted to choose the location to save your
drawings.

Export Image
Images showing the design area can be exported to several file formats, including .bmp, .jpg, and .png. These images
can display the shaded terrain and platforms, and can optionally include grid lines, colour keys and contour lines.

To export an image, click on File, Create Drawing and then Image. The export window will appear, like the one
shown below.
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The export options on this form are described below:

• ① Image Resolution: Higher quality images then the resolution can be obtained by increasing the resolution, but it
will take longer to generate the image and the file size will be larger. Note that the aspect ratio of the export image
is fixed, so adjusting either the width or the height will update the other dimensions automatically.

• ② Surface: You can indicate whether or not you want to include the shaded surfaces in your export. If included,
you can also choose whether or not to include colour keys beside the image. If you choose to include surfaces then
the shading in the export will be the same as in the main window.

• ③ Include Incline Lines: Indicate whether or not the platform slope lines should be included in the image export;
Include Outlines: Whether the image export is to include the element outline.

• ④ Contour lines: Define options. In the first two checkboxes, you can indicate whether you want to include
contour lines in the export image. If included, you can choose whether or not contour lines should be shown inside
the platforms; otherwise they will only be shown on the existing terrain. If contour lines are to be drawn, you must
also specify which level the lines should be drawn at, using one of the following methods:

• Fixed Contour Intervals of... If this option is selected, contour lines will be shown with fixed intervals (e.g.
every 20m). You can also specify a level to start the contour lines from. Use this to ensure a contour line
is drawn at a particular level, such as 0m. Note that contour lines will be drawn both above and below this
starting line at the specified interval to cover all of the ground.

• Fixed Contour Levels at... If this option is selected, the levels of each contour line can be specified by typing
into the box, allowing for contour lines to be drawn at irregular intervals. Contour level values which are typed
must be separated by a comma.

• ⑤ Grid Lines: In the first check box specify whether or not you want grid lines to be included. If grid lines are to
be included, then the grid line spacing and the text size for grid lines can be increased or reduced by clicking on
the + and - buttons.

Once the export settings have been finalised, click OK. You will be prompted for the location to save the export file
and the file format to save.

Notes on 3D View Images : The image export can only produce images in the design view. To export an image of the
project in one of the 3D views it is best to use the Windows Snipping Tool after putting the program into Presentation
Mode. Within the program, switch to one of the 3D views and navigate to the position you want. Then, from the
Display menu, select Presentation Mode. Use the windows snipping tool to take a screen capture of the area that you
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want and then exit presentation mode by hitting the Esc key. For instruction on how to use the Snipping Tool, refer to
Windows Support: Use Snipping Tool to capture screenshots.

Image export customisations are discussed in our Exports - Images
video, with a demonstration of capturing 3D views using the Windows
Snipping Tool later in the video.

Export to LandXML
The project data in Kubla Cubed can be exported to LandXML. LandXML is a widely supported format used for
transferring engineering and surveying data between different programs. Many specialist software applications can
import\export this format, visit www.landxml.org for an extensive list of software that can import\export LandXML.
LandXML is the recommended method for transferring TINS between Kubla Cubed and other programs.

When developing workflows for use with machine control systems it is sometimes necessary to use LandXML and
CAD exports in tandem. Typically, LandXML for the TINS and CAD for the linework.

To export project data to LandXML click on File, Export and then LandXML. The LandXML export window will
appear as shown below.

The available options on this form are described below:

• ① The phases drop-down allows you to select which phases are exported to LandXML. By default, only the
selected phase is exported. Unlike CAD, LandXML does not have a layer system so it is advantages to only export
the data you need to avoid the confusion of having a long list of objects that aren't required.

https://support.microsoft.com/en-gb/windows/use-snipping-tool-to-capture-screenshots-00246869-1843-655f-f220-97299b865f6b
https://youtu.be/6lt6TyiyHYQ
https://youtu.be/6lt6TyiyHYQ?t=132
http://www.LandXML.org


• ② In this section you select whether the export should include the data that the user has input into the project
(contours, points boundaries etc...). For many workflows this information is somewhat redundant and only the
TINS are needed, however it can be useful in other design programs.

• ③ In this section you can choose whether to include the TINS in the export. TINs are the best way of transferring
surfaces from Kubla Cubed to another program so you should usually keep this option checked.

Disturbance Area Only In some scenarios when exporting proposed surfaces, you will not want the undisturbed
ground in the model. If for instance you were exporting a surface for use in another cut\fill analysis you would
only want the elevations in the disturbance area only.

• ④ In this section you can choose to generate surface contour lines. Be aware that contour lines that have been
used to define 'Feature Surfaces' in Kubla Cubed will be included if 'Input Data' is checked and are not the contour
lines referred to in this section. The contour lines in this section are an entirely new set that can be generated from
the entire proposed surface.

• Starting At In this box you can set what level the contour lines start at, it is advised to start on a round number.
The default will be set to the bottom of the surface rounded down.

• Contour Interval In this box you can set the interval distance between each contour line. Very small contour
intervals can cause large export times and large file sizes.

• ⑤ As well as generating contour lines from the TINS you can also export gridded data. This can be useful for
importing into other programs that do not support TIN import. It also can be used to create a cut\fill plan for site
engineers.

• Origin Point In this box you can set the location of the origin point. The grid will extend out from here in all
directions until it exceeds the extents of the surface. It is recommended that rounded numbers are used. By
default, it is set to the bottom left rounded to a whole number.

• Grid Interval In this box you can set the distance between each grid point. Very small grid intervals can cause
large export times and large file sizes.

• ⑥ Earthworks linework created by Kubla Cubed can also be included in the LandXML format.

• Outlines -The outlines of the earthworks can be exported, this can be useful for knowing the location of
designed features such as building pads, roads, ponds etc...

• Incline Lines - Kubla Cubed generates 'incline lines' to mark the generated side slopes joining earthworks
elements to the ground. You can choose to include these in the file.

• Cut\Fill Lines - The lines can be exported in red and blue which show the earthworks cut\fill boundaries.
• ⑦ The preview can be used to give a good indication of what the exported file will contain. It is especially useful

for previewing the density of the generated gridded data and generated contour lines. Please note that not all
entities will show in the preview. When multiple phases are selected for export you can cycle through which phase
to preview using controls that will appear at the bottom of the preview panel. Multiple phases are not previewed at
together to avoid confusion.

Once the export settings have been finalised click OK. You will be prompted for the location to save the LandXML
file.

The Working with LandXML Files (.xml) video begins by importing
existing and proposed surfaces from LandXML using Triangle Surfaces.
It then explores options for exporting a Kubla Cubed project to a
LandXML file.

https://youtu.be/I8Jf541JtH0


Chapter

20
Export to CAD

Topics:

• CAD Export Options

This section explores the process of exporting project data from Kubla
Cubed to a CAD (.dwg, .dxf) file, offering a comprehensive guide for CAD
technicians and those integrating data into machine control systems.

The chapter covers the export options available and details the steps involved
in the export process, including considerations for phase selection, input data
inclusion, TINS, and various export settings.
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CAD Export Options
The project data in Kubla Cubed can be exported to an CAD (.dwg, .dxf) file. These are a widely supported formats
used for transferring engineering and surveying data between different CAD programs. Using the data exported from
Kubla Cubed a CAD technician can produce PDF files of the data for distribution or combine with other CAD data
of the site to create complex drawings. For exampled, the gridded data could be overlaid on the original site plan to
produce a detailed visualisation of the cut\fill.

When developing work-flows for use with machine control systems it is sometimes necessary to use LandXML and
CAD exports in tandem. Typically, LandXML for the TINS and CAD for the linework.

To export project data to CAD, click on File, Export and then CAD Data. The CAD export window will appear as
shown below.

The available options on this form are described below:

• ① The phases drop-down allows you to select which phases are exported to CAD. By default, only the selected
phase and the existing phase is exported. In the file layers are used to separate the entities by phase.

• ② In this section you select whether the export should include the data that the user has input into the project
(contours, points boundaries etc...).

• ③ In this section you can choose whether to include the TINS in the export. Often the TINS are not required if
you are just interested in a contour line or gridded data visualisation.

• Disturbance Area Only - In some scenarios when exporting proposed surfaces, you will not want the
undisturbed ground in the model. If for instance you were exporting a surface for use in another cut\fill
analysis you would only want the elevations in the disturbance area only.

• Shade Surfaces - The option cuts the mesh into different areas/clusters for different colours. Note: This results
in multiple meshes, which may not be suitable for import to other software. Unchecking this option will retain
the original mesh integrity.
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• ④ In this section you can choose to generate surface contour lines. Be aware that contour lines that have been
used to define 'Feature Surfaces' in Kubla Cubed will be included if 'Input Data' is checked and are not the contour
lines referred to in this section. The contour lines in this section are an entirely new set that can be generated from
the entire proposed surface.

• Label Contours - You can choose to turn off the labelling of contour lines, however as CAD has a special
entity for this exact scenario it is recommended it is left turned on.

• Starting At - In this box you can set what level the contour lines start at, it is advised to start on a round
number. The default will be set to the bottom of the surface rounded down.

• Contour Interval - In this box you can set the interval distance between each contour line. Very small contour
intervals can cause large export times and large file sizes.

• ⑤ As well as generating contour lines from the TINS, you can also export gridded data. This can be useful for
importing into other programs that do not support TIN import. It also can be used to create a cut\fill plan for site
engineers.

• Label Points - You can choose to turn off the labelling of points as it saves space in the file. Be aware that
points without labels will only be useful as an import into other programs, gridded points with no labels in a
CAD drawing would have little meaning.

• Origin Point - In this box you can set the location of the origin point. The grid will extend out from here in
all directions until it exceeds the extents of the surface. It is recommended that rounded numbers are used. By
default, it is set to the bottom left rounded to a whole number.

• Grid Interval - In this box you can set the distance between each grid point. Very small grid intervals can cause
large export times and large file sizes.

• ⑥ Earthworks linework created by Kubla Cubed can also be included in the CAD export.

• Outlines - The outlines of the earthworks can be exported, this can be useful for knowing the location of
designed features such as building pads, roads, ponds etc...

• Incline Lines - Kubla Cubed generates 'incline lines' to mark the generated side slopes joining earthworks
elements to the ground. You can choose to include these in the file.

• Cut\Fill Lines - The lines can be exported in red and blue which show the earthworks cut\fill boundaries.
• ⑦ The preview can be used to give a good indication of what the exported file will contain. It is especially useful

for previewing the density of the generated gridded data and generated contour lines. Please note that not all
entities will show in the preview. When multiple phases are selected for export you can cycle through which phase
to preview using controls that will appear at the bottom of the preview panel. Multiple phases are not previewed
all together to avoid confusion.

Once the export settings have been finalised click OK. You will be prompted for the location to save the DXF file.

Note:  When the project's element names contain characters not supported by the export format, those characters will
be removed. This only affects the export; the original project element names remain unchanged. A notification prior
to export will show which names have been altered.



The Exports - CAD Files video demonstrates the options for customising
CAD exports.

https://youtu.be/aUyAgQkUoxg
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Export to BIM and/or Machine Control

Topics:

• Exporting for BIM Software
• Exporting for Machine Control

Systems

BIM stands for Building Information Modelling and is intended to make the
construction process more efficient by recording data regarding a building's
construction and ongoing maintenance. Efforts are also underway to establish
open standards so widespread sharing of this data is possible between stake
holders. Kubla Cubed cannot export directly to a BIM format (e.g IFC);
however, the topography and positional data produced in Kubla Cubed can be
exported and then imported into those systems.

Machine Control systems consist of hardware and software that is installed on
earthmoving equipment that can give the operator a visual guide on where to
excavate, both in 2D and 3D. Like BIM, Kubla Cubed cannot export directly
to the propriety formats used on the systems of various manufacturers.
However, it can export data that can then be imported into the software
provided by the manufacturers for create machine control files.

In this chapter, we will explore some of the options for exporting Kubla
Cubed data to BIM and Machine Control.
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Exporting for BIM Software
Most BIM systems support the import of data using CAD files (e.g. .dwg, .dxf), so this is the best option for
importing linework, such as earthworks definition boundaries, measurement positions, lengths and areas. You can do
this by selecting File from the menu bar and then Export → CAD Data.

However, when it comes to the topography, things get a bit more complicated. Kubla Cubed uses TINS for calculating
and storing topography. If a BIM program also supports TINS, it is the preferred method of importing data. However,
some BIM systems do not support TIN. In such cases, they might accept points from the TIN but not the triangle data,
resulting in changes to the imported surface. In situations where a BIM software does not support TIN, you can export
the surfaces as either a high-density point cloud or contour lines.

To do this, select the following options from File → Export → CAD Data screen to generate gridded points for
integration into the BIM system. The image below shows which options to choose.

Exporting for Machine Control Systems
Each producer of machine control systems provides their own software for preparing a file that can be uploaded to
earthmoving machinery. Many of these software products support the import of both CAD (.dwg, .dxf) and Land
XML (.xml) files. Therefore, you can export all your data to either of those formats, and it should import seamlessly.

To do this, navigate to:

File → Export → CAD Data

or
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File → Export → Land XML

Sometimes, machine control systems work better with one format over another. It has been suggested CAD files work
better for line work, while Land XML files for TINS. However, it is easier to stick to one file format unless there
problems arise.

It's worth noting, some older machine control systems may not support TINS but do support point clouds. In such
cases, you will need to generate gridded data in the same way as suggested for BIM Software that does not support
TIN.
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Troubleshooting

Topics:

• Essential Project Checks
• Software Performance
• Error Messages in Kubla Cubed

The troubleshooting section offers both quick tips and a more detailed
explanation of how validation works in Kubla Cubed. This chapter aims to
assist you in finding to common problems on your own.

Within the troubleshooting section, you'll also find information about the error
and warning messages you might encounter. For instancce, if your intention
is to model a site spanning 300 metres, a warning would be triggered, if you
accidentally set the site size to 300 millimetres!
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Essential Project Checks
Project Checks

A computer model can only be as good as the data input to it. A frequently used industry phrase is 'GIGO' (Garbage
In Garbage Out). Therefore, checking your input is essential to ensure that no mistakes have been made during the
various stages of the project. The checks should be made after the data is input (e.g., check the site plan after it has
been imported). However, we also recommended the following checks are done at the end of each project before
producing reports...

Table 1: Scale Check

Verify that dimensions on the site plan are correct.
Press and hold the 'M' key on your keyboard, then
drag your mouse from the starting point ① to the
endpoint ② over a known length ③. If the value
④matches that on the site plan, then you have
scaled correctly. Be sure to pick a considerable
length for comparison to eliminate the possibility
of small inaccuracies going un-noticed.

Alternatively, you can use the 'Length'
Measurement element ①. Locate this element by
double clicking on the 'Measurements' panel in
the right-hand side of the program. For detailed
instructions, see our  Count, Length and Area
Measurements video. The added benefit of this
method is that the element remains in place and
can be referenced each time new site plan edits
are made, helping ensure nothing goes unnoticed
or becomes 'broken'.

https://shorturl.at/buJPU
https://shorturl.at/buJPU
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Table 2: Vertical Exaggeration Check

To help identify incorrect Z values and to a lesser
extent, XY values, exaggerate the terrain height.
Switch to one of the 3D cameras to show the
Vertical Exaggeration Tool. Move the tool's slider
up/down to highlight obvious mistakes such as
height spikes.

Table 3: Elevation Spot Check

Going back to check each point's height
individually would be a laborious effort.
However, you can streamline the process by
changing the cursor options to display the XYZ
values and then mousing over the desired points.
To do this, go to the menu, select 'Settings'.
Within the sub menu 'Cursor', select the options
X: Y: and then Z: (Proposed) and/or Z: (Ground).
Now, when you hover your mouse over terrain,
the selected dimension values will show the status
beneath the cursor.

Table 4: Elevation Cross Section Check

Draw a cross-section line across key areas of
your site. View each section's graph within Kubla
Cubed and examine where the proposed line rises
above and falls below the existing. By moving
the mouse across the graph, you can also check
individual sections are precisely as expected
under the cursor.
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Table 5: Cut & Fill Range and Levels Check

To help check for incorrect Z values refer to the
on-screen Results Panel.  located on the left-
hand side. In the Cut & Fill table, examine the
Range and Levels to ensure they align with your
expectations. This can highlight any errors and
you can then revisit your input data to make
necessary corrections.

Table 6: Input Validation Check

Once all your data has been input, navigate to the
main menu, select 'File' -> 'Create Spreadsheet',
and then choose 'Input Data'. Verify that the
Spreadsheet's content matches your original input
data. For example, if using the offset method,
offsets are all set to a minus value. Also, check
the level range of each element and height/depth
values.

Software Performance
In cases where you encounter delays in software performance, this section offers suggestions to enhance speed.

Enable/Disable

Projects with many elevation and measurement elements can cause a delay when defining new elements. One method
to speed up this process is to use disable elements that are not currently being edited. This can be achieved by
selecting an element/multiple elements then clicking the Power button. This approach is particularly effective if you
have added Volume Regions to your project. See The Measurements Panel on page 68.

Remember to re-enable elements by clicking the power button again, once you have finished editing/adding new
elements. This will then recalculate the project and it will report all the estimation volumes and measurements.

Turn Site Plan Off

Hiding site plans or turning them off can offer some resolution to a delay. See Setting Visibility on page 41 for more
details.

Export Phase as TIN and Import as Triangle Surface

When a feature surface contains a lot of data (points, contours, breaklines), it can cause a lag in the project. You can
reduce this delay by following these steps:

1. File → Export → CAD Data
2. Phases = e.g., Existing
3. Tick 'Include Triangulations'; all other sections must be unticked.
4. If exporting a Proposed phase, tick 'Disturbance Area Only'.
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5. Click OK → save your renamed file to your specified location.
6. In the Existing Phase: Delete the Feature Surface
7. In the Existing Phase: Add → Triangle Surface. See Existing Defined with Triangles on page 103.
8. Browse to find the exported TIN file → Select → click OK
9. Left-click on the surface to load → click OK
10. The surface will load and display in the project. If a Proposed phase, set Side Batters to 'Off'.

Error Messages in Kubla Cubed
All software encounters error messages from time to time and Kubla Cubed is no different. In this chapter, we discuss
the ‘Calculation Error’ message, which may occur when working on complex projects. We also discuss Kubla
Cubed's calculation steps and the error reporting features. This section discusess quite advanced topics and is intended
for experienced users.

Overview

Calculation error messages in Kubla Cubed are displayed when the calculations fail, or where a validation step
fails. Validation steps are run at numerous points during the calculation to ensure the integrity of the final result. No
calculation engine is going to be entirely error-free, especially one whose calculations are based on Triangular Prisms,
as in Kubla Cubed. This method is the most accurate, but is also far, far more technically challenging than the grid
and cross-section methods that are used by some other earthworks software.

Kubla Cubed offers users the flexibility to create as many phases of work as they wish, with each phase containing
an unlimited number of earthworks elements. While this flexibility is advantageous, it also allows for very complex
projects to be defined, increasing the likelihood of calculation errors compared to more restrictive software.

Calculation Steps

To understand the sources of calculation errors, it is helpful to understand the steps involved in the calculation. We
will briefly summarise the process below. These steps are repeated for each phase in the project.

For each earthworks element in a phase, there is a three-step process:

Step One : Generating the surface mesh.

For a Platform, this is trivial and unlikely to cause an
error. However, it is potentially quite complicated for a
Feature Surface with many ground features. It can also
be challenging for a Reduce or Raise, where the ground
below is complex.

Step Two : Generating batter slopes.

Batter slopes are the side slopes that will be used to
connect the surface mesh to the terrain. The complexity
of this process depends largely on the complexity of
the element's outline. However, if the batters are set to
vertical (0.01) this step is quite straightforward for the
software to complete.
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Step Three : Merging the element with the terrain.

This is usually a fairly challenging step for the software,
particularly if the existing and/or proposed meshes are
complex.

Once all of the earthworks elements have been processed in this way, two meshes will exist: the mesh at the start of
the phase and the mesh after all the elements have been merged into it. The final step is to project the initial mesh
edges onto the final mesh. This will create a mesh which contains all the edges of both the initial and the final meshes.
This ‘Calculation Mesh’ is crucial to generate volumes and to present cut and fill maps. However, this final step of the
process is extremely complex and commonly a source of error messages.

If an error occurs when merging an earthworks element into the terrain, the software will identify the element that
caused the error. However, if an error occurs during the generation of the calculation mesh, it is not possible to
identify a specific element that has caused the problem. For this reason, these errors can be particularly difficult for
our customers to resolve with the current error messages.

General Approach

At Kubla, we use the following approaches to minimise the frequency and impact of calculation errors:

• Thorough validation of user-input data. This
minimises the likelihood of situations that may lead
to errors.

• Continual improvement to make the calculations as
robust as possible. Our developers are constantly
working through calculation errors reported by users;
fixes are included in regular software updates.

• Presenting error details to the user about errors when
they occur, to empower them to resolve the issues
independently.

• Directly supporting customers who run into
calculation errors.

We believe that our validation, calculations and support
are amongst the best available in the industry, although
we continue to improve these areas. However, user
feedback has indicated that error messages can be
difficult to interpret and do not always provide enough
information for them to find a solution on their own. For
this reason, the latest release of the software includes
work to improve this aspect of the software. This work is
ongoing and will continue in subsequent updates.

The validator in Kubla Cubed aims to prevent errors in
the terrain definition. It will block blatant errors, such as
contour lines crossing each other with different levels. It
will also warn the user about likely errors, such as one
elevation which is very different from all of the others.

Improvements to Error Reporting

In earlier versions of the software, only one error message could be displayed to the user. This provided limited ability
for our developers to communicate the source of the error to the user of the software. A significant upgrade to error
reporting now presents the full error path to the user, allowing for more detailed information about the error.

However, the most notable improvement to error reporting is the capability to display the region where the error
has occurred on the screen. This empowers our users to inspect the problematic area, and see if they have made any
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mistake, or if they could simplify the way they have defined the ground levels in this area. Sometimes, even just
moving some features in this area by a negligable amount may cause errors to go away.

However, it’s essential to understand, that due to the complexity of the calculations, it’s not always obvious where
they have initially gone wrong. The displayed error regions will sometimes represent a ‘best guess’ of the location
of the error source. The project should be checked in the vicinity of the identified error region, as well as within the
region itself. It should also be noted that it is not possible to identify an error region for every type of error, and it
will not always be displayed. However, the most common errors will now have error regions, and coverage will be
expanded to more error types in the future.
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